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Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a
Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted
nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an
express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components
in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user.
The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such
use and in doing so indemnifies Cypress against all charges. 

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by
and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty
provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create
derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom
software and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as
specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this
Source Code except as specified above is prohibited without the express written permission of Cypress. 

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS
MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials
described herein. Cypress does not assume any liability arising out of the application or use of any product or circuit
described herein. Cypress does not authorize its products for use as critical components in life-support systems where a
malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product
in a life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies
Cypress against all charges. 

Use may be limited by and subject to the applicable Cypress software license agreement. 

CySmart, F-RAM, PRoC, Programmable System-on-Chip, and PSoC Creator are trademarks, and PSoC and CapSense are
registered trademarks of Cypress Semiconductor Corporation. All other products and company names mentioned in this
document may be the trademarks of their respective holders.

Purchase of I2C components from Cypress or one of its sublicensed Associated Companies conveys a license under the
Philips I2C Patent Rights to use these components in an I2C system, provided that the system conforms to the I2C Standard
Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name - NXP
Semiconductors.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress Datasheets. Cypress believes that its family of
products is one of the most secure families of its kind on the market today, regardless of how they are used. There may be
methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our knowledge, would
be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guarantee the security of
their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly
evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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Safety Information

The CY8CKIT-042-BLE Bluetooth Low Energy (BLE) Pioneer Kit is intended for use as a
development platform for hardware or software in a laboratory environment. The board is an open
system design, which does not include a shielded enclosure. Due to this reason, the board may
cause interference with other electrical or electronic devices in close proximity. In a domestic
environment, this product may cause radio interference. In such cases, the user may be required to
take adequate preventive measures. Also, this board should not be used near any medical
equipment or critical RF devices.

The CY8CKIT-042-BLE Bluetooth Low Energy (BLE) Pioneer Kit is intended for use as a
development, demonstration and evaluation platform for hardware or software in a laboratory
environment. The kit is not intended for general consumer use. Cypress recommends that the kit
only be used in a shielded room.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-042-BLE as shipped from the factory has been verified to meet with requirements of
CE as a Class A product.

The CY8CKIT-042-BLE boards contain electrostatic discharge (ESD)
sensitive devices. Electrostatic charges readily accumulate on the
human body and any equipment, which can cause a discharge without
detection. Permanent damage may occur on devices subjected to
high-energy discharges. Proper ESD precautions are recommended
to avoid performance degradation or loss of functionality. Store unused
CY8CKIT-042-BLE boards in the protective shipping package.
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General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform
procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD
protection by wearing an antistatic wrist strap attached to the chassis ground (any unpainted metal
surface) on the board when handling parts.

Handling Boards

CY8CKIT-042-BLE boards are sensitive to ESD. Hold the board only by its edges. After removing
the board from its box, place it on a grounded, static-free surface. Use a conductive foam pad if
available. Do not slide the board over any surface.

Battery Care and Use

■ Use the correct size and type of battery specified in this guide. 

■ Keep battery contact surfaces and battery compartment contacts clean by rubbing them with a 
clean pencil eraser or a rough cloth each time you replace batteries. 

■ Remove the battery from a device when it is not expected to be in use for several months. 

■ Make sure that you insert the battery into your device properly, with the + (plus) and – (minus) 
terminals aligned correctly. 

■ Do not place the battery next to metallic objects such as keys and coins.

■ Never throw the battery into fire.

■ Do not open up the battery.

■ Do not short the battery.

■ Do not subject the battery to high temperatures or high humidity.

■ Store the battery in a dry place.

■ Do not recharge a battery unless it is marked “rechargeable.”

Battery Disposal

Batteries can be safely disposed of with normal household waste. Never dispose of batteries in fire
because they can explode. It is important not to dispose of large amounts of batteries in a group.
Used batteries are often not completely “dead.” Grouping used batteries together can bring these
“live” batteries into contact with one another, creating safety risks.

End-of-Life/Product Recycling

The end-of-life cycle for this kit is five years from the date of
manufacture mentioned on the back of the box. Contact your nearest
recycler to discard the kit.
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Regulatory Compliance Information

The kit contains devices that transmit and receive radio signals in accordance with the spectrum
regulations for the 2.4-GHz unlicensed frequency range. 

Cypress Semiconductor Corporation has obtained regulatory approvals for this kit to be used in
specific countries. These countries include United States (FCC Part 15), Canada (IC RSS210) and
Japan (JRF/TELEC). Additional regional regulatory agency approval may be required to operate
these throughout the world.

This kit as shipped from the factory has been tested and found to comply with the limits/
requirements for following compliances: 

■ FCC as a class B digital device, pursuant to part 15 of the FCC Rules.

■ This Class B digital apparatus complies with Canadian ICES-003

Regulatory statements and Product Labeling

United States (FCC)

This equipment complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

The CY8CKIT-142 PSoC 4 BLE and CY5671 PRoC BLE modular transmitter must be labeled with
its own FCC ID number, and, if the FCC ID is not visible when the module is installed in to another
device, then the outside of the device into which the module is installed must also display a label
referring to the enclosed module. This exterior label can use wording such as the following:

Contains FCC ID: WAP-CY8CKIT-142 and WAP-CY5671, The enclosed device complies with Part
15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference and (2) this device must accept any interference received, including
interference that may cause undesired operation. Any similar wording that expresses the same
meaning may be used.

CAUTION: Any changes or modifications not expressly approved by
the party responsible for compliance could void the user’s authority to
operate the equipment.

Only the PCB antenna(s) that were certified with the module may be
used. Other antennas may be used only if they are of the same type
and have the same or lower gain.

The module must be recertified as a Class II permissive change if the
module is built into a different device than the EVB (evaluation board)
it was certified with.

THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY RADIO
OR TV INTERFERENCE CAUSED BY UNAUTHORIZED
MODIFICATIONS TO THIS EQUIPMENT. SUCH MODIFICATIONS
COULD VOID THE USER'S AUTHORITY TO OPERATE THE
EQUIPMENT.
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CAUTION: The changes or modifications not expressly approved by the party responsible for
Compliance could void the user’s authority to operate the equipment and the antennas for this
transmitter must be installed to provide a separation distance of 20 cm from all persons and must not
be co-located or operating in conjunction with any other antenna or transmitter.

Canada (IC)

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to
the following two conditions: (1) this device may not cause interference, and (2) this device must
accept any interference, including interference that may cause undesired operation of the device.

This equipment complies with radio frequency exposure limits set forth by Industry Canada for an
uncontrolled environment. This equipment should be installed and operated with minimum distance
20cm between the device and the user or bystanders.

CAUTION: Any changes or modifications not expressly approved by the party responsible for com-
pliance could void the user’s authority to operate the equipment.

This Module is labelled with its own IC ID. If the IC ID Certification Number is not visible while
installed inside another device, then the device should display the label on it referring the enclosed
module. In that case, the final end product must be labelled in a visible area with the following:

“Contains Transmitter Module IC 7922A-CY8CKIT142 and 7922A-CY5671”

OR 

“Contains IC: 7922A-CY8CKIT142 and 7922A-CY5671”

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio
exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit
pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique
subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux radiofréquences définies par Industrie
Canada pour un environnement non contrôlé. Cet équipement doit être installé et utilisé avec un
minimum de 20cm de distance entre le dispositif et l'utilisateur ou des tiers.

Ce module est étiqueté avec son propre ID IC. Si le numéro de certification IC ID n'est pas visible
lorsqu'il est installé à l'intérieur d'un autre appareil, l'appareil doit afficher l'étiquette sur le module de
référence ci-joint. Dans ce cas, le produit final doit être étiqueté dans un endroit visible par le texte
suivant: 

“Contains Transmitter Module IC 7922A-CY8CKIT142 and 7922A-CY5671”

OR 

“Contains IC: 7922A-CY8CKIT142 and 7922A-CY5671”
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Japan (TELEC)
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1. Introduction

Thank you for your interest in the CY8CKIT-042-BLE Bluetooth Low Energy (BLE) Pioneer Kit. The
BLE Pioneer Kit enables customers to evaluate and develop BLE projects using the PSoC® 4 BLE
and PRoC® BLE devices.

Bluetooth SMART™ or Bluetooth® Low Energy (BLE) is a fully featured, layered, communication
protocol that includes a 2.4 GHz Radio, a link layer and an application layer. However, in order to
implement your projects using PSoC 4 BLE or PRoC BLE, you do not need to understand the
complex protocol. The Cypress BLE solution which includes the device, BLE Component and the
BLE Firmware Stack will take care of it for you. The Cypress BLE Firmware Stack is royalty free.

You will use two software tools, PSoC Creator and CySmart Central Emulation Tool to develop and
debug your BLE project. PSoC Creator is Cypress’ standard Integrated Development Environment
(IDE). The BLE protocol has been abstracted into an easy drag-and-drop BLE Component in PSoC
Creator. CySmart Central Emulation Tool is a Central emulation tool for Windows PCs. CySmart
Central Emulation Tool provides an easy-to-use Graphical User Interface (GUI) to enable customers
to test and debug their BLE projects. 

The BLE Pioneer Kit offers footprint-compatibility with Arduino™ shields as well as 6-pin Digilent
Pmod daughter cards. In addition, the kit features a CapSense® slider, an RGB LED, a push button
switch, an onboard programmer/debugger and USB-UART/I2C bridge functionality block (KitProg), a
coin cell battery holder and a Cypress F-RAM. The BLE Pioneer Kit supports 1.9 V, 3.3 V or 5 V as
operating voltages. 

The BLE Pioneer Kit supports two devices: PSoC 4 BLE and PRoC BLE.

PSoC 4 BLE is a 32-bit, 48-MHz ARM® Cortex™-M0 BLE solution with CapSense, 12-bit Analog
Front End (1x SAR ADC, 4x Low-Power Opamps, 2x Low-Power Comparators, 2x Current DACs),
4x TCPWM1, 2x SCBs2, 4x UDBs3, LCD4, I2S5 and 36 GPIOs. 
PSoC 4 BLE provides a complete solution for sports and fitness monitors, wearable electronics,
medical devices, home automation systems and sensor-based low-power systems for the Internet of
Things (IoT). 

PRoC BLE is a 32-bit, 48-MHz ARM® Cortex™-M0 BLE solution with CapSense, 12-bit ADC, 
4x TCPWM1, 2x SCBs2, LCD4, I2S5 and 36 GPIOs. 
PRoC BLE provides a complete solution for BLE connectivity, HID, remote controls and toys.

Both devices are supported by a royalty-free Stack compatible with Bluetooth 4.1. 

Notes:

1. Configurable timer, counter, pulse-width modulator.

2. Serial communication blocks (configurable to I2C, SPI or UART).

3. Universal Digital Blocks.

4. Configurable liquid crystal display driver.

5. Configurable integrated interchip sound serial bus interface.
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Introduction

1.1 Kit Contents

The BLE Pioneer Kit contains the following items, as shown in Figure 1-1.

■ BLE Pioneer Baseboard preloaded with the CY8CKIT-142 PSoC 4 BLE Module

■ CY5671 PRoC BLE Module

■ CY5670 CySmart USB Dongle (BLE Dongle)

■ Quick start guide

■ USB Standard-A to Mini-B cable

■ Four jumper wires (4 inch) and two proximity sensor wires (5 inch)

■ Coin cell (3V CR2032)

Figure 1-1.  Kit Contents

If any part of the BLE Pioneer Kit is missing, contact your nearest Cypress sales office for help:
www.cypress.com/go/support.

www.cypress.com/go/support
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1.2 BLE Pioneer Baseboard Details

The BLE Pioneer Baseboard consists of the blocks shown in Figure 1-2.

1. RGB LED

2. Module reset button

3. CapSense proximity header

4. User button

5. CapSense slider

6. Arduino compatible I/O headers (J2/J3/J4)

7. Arduino compatible power header (J1)

8. Digilent Pmod compatible I/O header (J5)

9. Cypress F-RAM 1-Mb (FM24V10-G)

10.PSoC 5LP - programmer and debugger (CY8C5868LTI-LP039)

11.PSoC 5LP I/O header (J8)

12.Coin cell holder (bottom side)

13.USB connector (J13)

14.Power LED and Status LED

15.System power supply jumper (J16) - LDO 1.9 V~5 V

16.BLE power supply jumper (J15) - for current measurement

17.Module headers (J10/J11)

Figure 1-2.  BLE Pioneer Baseboard
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Figure 1-3 shows a markup of the onboard components, where red module denotes the PSoC 4 BLE
module and black module denotes the PRoC BLE module.

Figure 1-3.  BLE Module Markup

32.768 KHz
crystal

32.768 KHz
crystal
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The BLE Dongle board consists of the blocks shown in Figure 1-4.

Figure 1-4.  BLE Dongle Markup

1.3 PSoC Creator™

PSoC Creator is a state-of-the-art, easy-to-use integrated design environment (IDE). It is a
revolutionary hardware and software co-design environment, powered by a library of preverified and
precharacterized PSoC Components™. 

With PSoC Creator, you can:

■ Drag and drop PSoC Components to build a schematic of your custom design

■ Automatically place and route components and configure GPIOs

■ Develop and debug firmware using the included component APIs

PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler chains
and production programmers for PSoC devices.

For more information, visit www.cypress.com/psoccreator.

1.4 Getting Started

This guide will help you get acquainted with the BLE Pioneer Kit:

■ The Software Installation chapter on page 23 describes the installation of the kit software. This 
includes the PSoC Creator IDE for development and debugging applications, PSoC Programmer 
for programming hex files, and the CySmart Central Emulation Tool for BLE Central emulation.

■ The Kit Operation chapter on page 27 describes the major features of the BLE Pioneer Kit such 
as USB-UART and USB-I2C bridges and functionalities such as programming and debugging.

■ The Example Projects chapter on page 41 describes multiple PSoC 4 BLE and PRoC BLE code 
examples that will help you understand how to create your own BLE application using the BLE 
Component and device.

■ The Hardware chapter on page 85 details the hardware content of the BLE Pioneer Kit and BLE 
Dongle, and the hardware operation.

■ The Advanced Topics chapter on page 111 explains the functionality of the kit features, such as 
the USB-UART bridge, USB-I2C bridge, F-RAM, iOS app, and the CySmart Central Emulation 
Tool.

■ The Appendix on page 117 provides schematics, board layouts, KitProg LED status, and the bill 
of materials (BOM).

www.cypress.com/psoccreator
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1.5 Additional Learning Resources

Visit www.cypress.com/go/psoc4ble and www.cypress.com/procble for additional learning resources
including datasheets, technical reference manuals, and application notes.

Visit www.cypress.com/go/cysmart for information on the CySmart Central Emulation Tool.

1.5.1 Beginner Resources

PSoC Creator Training: www.cypress.com/go/creatorstart/creatortraining

1.5.2 Application Notes

Visit www.cypress.com/appnotes to view a growing list of application notes for PSoC 3, PSoC 4,
PSoC 4 BLE, PRoC BLE, and PSoC 5LP.

Visit this site for PSoC 4BLE and PRoC BLE application notes.

1.5.3 PSoC Creator Example Projects

These simple example projects demonstrate how to configure and use PSoC Creator components.
To open an example project in PSoC Creator, go to File > Example Project (see Figure 1-5) and
choose the required example project. 

Figure 1-5.  PSoC Creator Example Projects

www.cypress.com/go/psoc4ble
www.cypress.com/proc ble
www.cypress.com/go/cysmart
www.cypress.com/go/creatorstart/creatortraining
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=1353&applicationID=0&l=0
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=5283
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1.5.4 Component Datasheets

To open the datasheet for any component, right-click on the component and select Open Datasheet
(see Figure 1-6). 

Figure 1-6.  Opening Component Datasheet

1.5.5 Bluetooth Learning Resources

The Bluetooth Developer Portal provides material by the Special Interest Group (SIG) for learning
various aspects of the Bluetooth Low Energy protocol and systems. Some of them are:

■ Training videos

■ GATT profiles

■ Bluetooth community forum

1.5.6 Learning From Peers

Cypress Developer Community Forums: Visit www.cypress.com/forums

1.5.7 Other Related Resources

■ Digilent PMod: www.digilentinc.com/pmods/

■ Arduino: http://arduino.cc/en/Main/ArduinoBoardUno

1.6 Technical Support

For assistance, go to our support web page, www.cypress.com/support, or contact our customer
support at +1 (800) 541-4736 Ext. 2 (in the USA) or +1 (408) 943-2600 Ext. 2 (International).

https://developer.bluetooth.org/Pages/default.aspx
https://developer.bluetooth.org/DevelopmentResources/Pages/Training-Videos.aspx
https://developer.bluetooth.org/gatt/profiles/Pages/ProfilesHome.aspx
https://developer.bluetooth.org/Community/SitePages/Community Home.aspx
http://www.cypress.com/?app=forum&source=search_advanced
www.digilentinc.com/pmods/
http://arduino.cc/en/Main/ArduinoBoardUno
http://www.cypress.com/go/support
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1.7 Documentation Conventions

Table 1-1.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:
C:\...cd\icc\

Italics
Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Creator User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:
File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman
Displays an equation:
2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.
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1.8 Acronyms
Table 1-2.  Acronyms Used in this Document

Acronym Definition

ADC Analog-to-Digital Converter

API Application Programming Interface

BD address Bluetooth Device address

BLE Bluetooth Low Energy

CDC Communications Device Class

COM Communication Port

DVD Digital Video Disc

ESD Electrostatic Discharge

F-RAM Ferroelectric Random Access Memory

GUI Graphical User Interface 

GPIO General Purpose Input/Output

I2C Inter-Integrated Circuit

IAS Immediate Alert Service

IDAC Interconnecting Digital-Analog Converter

IDE Integrated Development Environment

LDO Low Drop Out (voltage regulator)

LED Light-Emitting Diode

LP Low Power

LPT Line Print Terminal

PHY Physical Layer

PrISM Precise Illumination Signal Modulation

PRoC Programmable Radio-on-Chip

PRM Protocol Service Multiplexer

PSoC Programmable Systems-on-Chip

PWM Pulse-Width Modulation 

QFN Quad Flat No-lead (package)

RGB Red Green Blue

SAR Successive Approximation Register

SMA SubMiniature version A

SPI Serial Peripheral Interface 

SWD Serial Wire Debug

UART Universal Asynchronous Receiver Transmitter

USB Universal Serial Bus
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2. Software Installation

This chapter describes the steps to install the software tools and packages on a PC for using the
BLE Pioneer Kit. This includes the IDE in which the projects will be built and used for programming.

2.1 Before You Begin

All Cypress software installations require administrator privileges. Ensure you have the required
privileges on the system for successful installation. Before you install the kit software, close any
other Cypress software that is currently running.

2.2 Install Software

Follow these steps to install the BLE Pioneer Kit software:

1. Download the BLE Pioneer Kit software from www.cypress.com/CY8CKIT-042-BLE. The
software is available in the following formats:

a. CY8CKIT-042-BLE Kit Complete Setup: This installation package contains the files related to
the BLE Pioneer Kit. However, it does not include the Windows Installer or Microsoft .NET
framework packages. If these packages are not on your computer, the installer directs you to
download and install them from the Internet.

b. CY8CKIT-042-BLE Kit Only Package: This executable file installs only the BLE Pioneer Kit
contents, which include code examples, hardware files, and user documents. This package
can be used if all the software prerequisites (listed in step 5) are installed on your PC.

c. CY8CKIT-042-BLE DVD ISO: This file is a complete package, stored in a DVD-ROM image
format, that you can use to create a DVD or extract using an ISO extraction program such as
WinZip or WinRAR. The file can also be mounted similar to a virtual CD/DVD using virtual
drive programs such as ‘Virtual CloneDrive’ and ‘MagicISO’. This file includes all the required
software, utilities, drivers, hardware files, and user documents.

2. If you have downloaded the ISO file, mount it on a virtual drive; if you do not have a virtual drive
to mount, extract the ISO contents using the appropriate ISO extractor (such as MagicISO or
PowerISO). Double-click cyautorun.exe in the root directory of the extracted content or mounted
ISO if “Autorun from CD/DVD” is not enabled on the PC. The installation window will appear
automatically. 

Note: If you are using the “Kit Complete Setup” or “Kit Only Package” file, then go to step 4 for 
installation.

www.cypress.com/CY8CKIT-042-BLE
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3. Click Install CY8CKIT-042-BLE Kit to start the installation, as shown in Figure 2-1.

Figure 2-1.  Installer Screen

4. Select the folder in which you want to install the CY8CKIT-042-BLE kit-related files. Choose the
directory and click Next.

5. When you click Next, the CY8CKIT-042-BLE Kit installer automatically installs the required
software, if it is not present on your computer. The following software packages are required: 
Note: For the Kit Only Package, download and install the following prerequisites.

a. PSoC Creator 3.1 or later: Download the latest version from www.cypress.com/psoccreator.

b. PSoC Programmer 3.22 or later: This is installed as part of PSoC Creator installation
(www.cypress.com/programmer).

c. CySmart 1.0 or later: Download the latest version from www.cypress.com/cysmart.

www.cypress.com/psoccreator
www.cypress.com/programmer
www.cypress.com/cysmart
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6. Choose the Typical/Custom/Complete installation type in the Product Installation Overview
window, as shown in Figure 2-2. Click Next after you select the installation type.

Figure 2-2.  Product Installation Overview

7. Read the license agreement and select I accept the terms in the license agreement to
continue with installation. Click Next.

8. When the installation begins, a list of packages appears on the installation page. A green check
mark appears next to each package after successful installation.

9. Click Finish to complete the CY8CKIT-042-BLE kit installation.

10.Enter your contact information or select the Continue Without Contact Information check box.
Click Finish to complete the CY8CKIT-042-BLE kit installation.

11.After the installation is complete, the kit contents are available at the following location:

<Install_Directory>\CY8CKIT-042-BLE Kit

Default location:

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY8CKIT-042-BLE Kit

Windows 7 (32-bit): C:\Program Files\Cypress\CY8CKIT-042-BLE Kit

Note: For Windows 7/8/8.1 users, the installed files and the folder are read only. To use the installer
example project, follow the steps outlined in the Example Projects chapter on page 41.

The BLE Pioneer Kit installer also installs the CySmart Central Emulation Tool on your PC. This
software, along with the BLE Dongle, allows the PC to emulate as a BLE Central device. Refer to
CySmart Mobile Application on page 112 for more details on how to use the CySmart Central
Emulation Tool.

2.3 Windows 8.1 USB selective suspend setting

Windows 8.1 operating system issues a suspend command to connected USB device if there is no
activity on its USB bus. This may happen to BLE Pioneer Kit/BLE Dongle if the driver installation is
not complete or driver not found. In this situation, as a response to the suspend command from the
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operating system, the KitProg will shut down the on-board LDO to remain within the USB suspend
current requirement. Due to this, the BLE Pioneer Kit will not be powered and will not be functional.

To prevent this, take either of the two actions below:

1. Allow complete driver installation to take place on Windows 8.1 operating system before using 
the BLE Pioneer Kit.

2. Disable the USB selective suspend setting for BLE Pioneer Kit from Power Options on Windows 
8.1:

a. From Control Panel, go to Power Options.

b. Under Advanced settings, expand USB settings > USB selective suspend setting.

c. Select option to Disabled for Plugged in and On battery operation.

d. Select OK.
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This chapter introduces you to the BLE Pioneer Kit and the features that will be used as part of its
operation. We will discuss features such as USB connection, programming/debugging, and
programmer firmware update. The chapter also describes the USB-UART and USB-I2C bridges
along with the PC tools that can be used to communicate with the BLE device on the BLE Pioneer
Kit.

3.1 Theory of Operation

Figure 3-1, Figure 3-2, and Figure 3-3 show the block diagrams for the BLE Pioneer Baseboard,
PSoC 4 BLE/PRoC BLE Module, and BLE Dongle.

Figure 3-1.  BLE Pioneer Baseboard Block Diagram

The BLE Pioneer Baseboard acts as the baseboard for the PSoC 4 BLE (red module) and PRoC
BLE (black module). The BLE Pioneer Baseboard contains a PSoC 5LP device, that has KitProg
firmware, used as an onboard programmer or debugger, and for the USB-Serial interface.

The baseboard is Arduino form-factor compatible, enabling Arduino shields to be connected on top
of the board to extend the functionality of BLE modules. The board also features a 1-Mb F-RAM, an
RGB LED, a five-segment CapSense slider, a proximity header, a user switch, and a reset switch for
the PSoC 4 BLE and PRoC BLE devices on the module. The Pioneer board supports three voltage
levels: 1.9 V, 3.3 V, and 5 V.
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The BLE Pioneer Baseboard can also be used as a standalone programmer to program and debug
other BLE devices using serial wire debug (SWD), and as a USB-Serial interface. The KitProg
firmware on PSoC 5LP device enables bootloading PSoC 5LP over USB to upgrade the firmware. 

Figure 3-2.  PSoC 4 BLE/PRoC BLE Module Block Diagram

This BLE Pioneer Kit includes two modules. These modules act as a basic breakout board for the
CY8C4247LQI-BL483 (PSoC 4 BLE) and CYBL10563-56LQXI (PRoC BLE) device. The
PSoC 4 BLE and PRoC BLE Modules are identical except for the BLE device. 

The BLE Dongle is the wireless interface for the CySmart Central Emulation Tool. The BLE Dongle
has a PRoC BLE device for BLE communication and KitProg for onboard programming, debugging
and for the USB-Serial interface, as shown in Figure 3-3.

The BLE Dongle has a USB Type-A plug to connect the KitProg to the USB port of the host PC. The
KitProg then communicates with the PRoC BLE device over UART or multiplexed I2C or an SPI bus.
The BLE Dongle also features a user LED, a user switch, and a reset switch for the PRoC BLE
device. The BLE Dongle is powered directly through the USB port (VBUS) at 5.0 V. 

Figure 3-3.  BLE Dongle Block Diagram
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3.2 KitProg

KitProg is the hardware/firmware block for on-board programming, debugging and bridge
functionality. It is a common reusable hardware/firmware block used across many Cypress Kit
platforms. It consists of a PSoC 5LP which connects to the PC over an USB interface and connects
to the PSoC 4 BLE or PRoC BLE device over SWD, I2C and UART pins. 

The KitProg communicates with PSoC Programmer and PSoC Creator software to program/debug
the target PSoC 4 BLE or PRoC BLE over the SWD interface. The main advantage of an onboard
programmer/debugger is that users don’t have to buy an extra programmer/debugger hardware.

3.3 BLE Pioneer Kit USB Connection

The BLE Pioneer Kit powers from a PC over the USB interface (J13). It enumerates as a composite
device, as shown in Table 3-1. USB drivers required for this enumeration are part of the kit installer.
The kit should be installed properly for its correct operation. Visit 
 www.cypress.com/CY8CKIT-042-BLE for latest kit installer.

Figure 3-4.  KitProg Driver Installation (appearance may differ depending on Windows version)

3.4 Placing Modules on Baseboard

Plug the module into the BLE Pioneer Baseboard on headers J10 and J11, while keeping the
antenna directed outside. Note that the two parallel headers J10 and J11 are not equal (24-pin and
20-pin, respectively) and will not allow the module to be inserted in the opposite direction.

Table 3-1.  BLE Pioneer Kit Enumerated Interfaces

Port Description

USB Composite Device Composite device

USB Input Device USB-I2C bridge, Kitprog Command Interface

KitProg USB-I2C bridge, Programmer and Debugger

KitProg USB-UART USB-UART bridge, which appears as a COM# port

www.cypress.com/CY8CKIT-042-BLE


30 CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *B

Kit Operation

Figure 3-5.  Baseboard with J10 and J11 Headers to connect modules

To remove the modules from the BLE Pioneer Kit, hold the BLE Pioneer Kit in one hand and the
module in the other, as shown in Figure 3-6, and pull it out using a rocking motion.

Figure 3-6.  Remove module connected on BLE Pioneer Kit

3.5 Programming and Debugging BLE Device

The BLE Pioneer Kit and BLE Dongle can be programmed and debugged using the KitProg. Before
programming the device, ensure that PSoC Creator and PSoC Programmer are installed on the PC.
See the section Install Software on page 23 for more information.

3.5.1 Programming using PSoC Creator

1. Connect the BLE Pioneer Kit/BLE Dongle to the PC USB port, as shown in Figure 3-7. 
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Figure 3-7.  Connect USB Cable to J13

2. Load the desired example project in PSoC Creator from File > Open > Project/Workspace. 

3. Build the project by choosing Build > Build <Project Name> or [Shift] [F6], as shown in
Figure 3-8.

Figure 3-8.  Build an Example Project

4. If there are no errors during build, program the firmware by clicking Program button on toolbar or
pressing [Ctrl] [F5], as shown in Figure 3-9. This will program the device on the BLE Pioneer Kit/
BLE Dongle and it will be ready for use. 
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Figure 3-9.  Programming Device From PSoC Creator

3.5.2 Debugging using PSoC Creator

For debugging the project using PSoC Creator, follow steps 1-5 from Programming using PSoC Cre-
ator on page 30 followed by:

1. Click on Debug icon or press [F5], as shown in Figure 3-10.

Figure 3-10.  Start debug on PSoC Creator 

2. Once Creator opens in debug mode, use the buttons on toolbar for debugging.

For more details on using the debug features, see the Cypress application note Getting Started with
PSoC 4 BLE.

3.5.3 Programming using PSoC Programmer

PSoC Programmer (3.22 or later) can be used to program existing hex files into both the BLE Pio-
neer Kit or BLE Dongle. To do this, follow these steps.

1. Connect the BLE Pioneer Kit or BLE Dongle to PC and open PSoC Programmer from Start > All 
Programs > Cypress > PSoC Programmer <version> > PSoC Programmer <version>.

http://www.cypress.com/go/AN91267
http://www.cypress.com/go/AN91267
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2. Click the File Load button at the top left corner of the window. Browse for the desired hex file and 
click Open.

Figure 3-11.  Select Hex File

3. Go to File > Program to start programing the kit with the selected file.

Note: If the hex file does not match the device selected, then PSoC Programmer will throw an 
error of device mismatch and terminate programming.
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Figure 3-12.  Program Hex File to Kit

4. When the programming is finished successfully, indicated by a PASS message on the status bar, 
the BLE Pioneer Kit/BLE Dongle is ready for use. Close PSoC Programmer.
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3.6 Updating BLE Dongle for CySmart Central Emulation Tool

The BLE Dongle, provides a BLE Central mode capability using the CySmart Central Emulation Tool
(see CySmart Mobile Application on page 112) on the PC. The CySmart Central Emulation Tool on
the PC is the interface with which to configure the BLE Dongle and analyze the data transferred after
connecting with a BLE peripheral. 

The BLE Dongle works along with the CySmart Central Emulation Tool, as shown in Figure 3-13.
The CySmart Central Emulation Tool is installed as part of the BLE Pioneer Kit installation and can
be opened from Start > All Programs > Cypress > CySmart <version> > CySmart <version>.
The tool operation is explained in user guide of the tool, which can be accessed from Help > Help
Topics.

Figure 3-13.  BLE Dongle Interface on CySmart Central Emulation Tool

If the BLE Dongle contains custom firmware on PRoC BLE, the original CySmart firmware can be
programmed back to restore the CySmart functionality. It must be connected through the USB and
enumerated as KitProg. To do this, follow these steps:

1. Connect the BLE Dongle to the USB port on the PC.

2. Open PSoC Programmer by going to Start > All Programs > Cypress > PSoC Programmer
<version> > PSoC Programmer <version>.

3. Click the File Load button and browse to the location of the BLE_Dongle_CySmart.hex file. The
hex file is located at:
<Install_Directory>\CY8CKIT-042-BLE Kit\<version>\Firmware\ BLE
Dongle\Hex Files\

Note: If Cypress releases new versions of the CySmart Central Emulation Tool and the BLE Don-
gle firmware, then the CySmart Central Emulation Tool will display a message requesting to 
update the firmware, as shown in the following figures.
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Figure 3-14.  Update BLE Dongle Firmware with Hex from Latest Kit Installer

Figure 3-15.  Update BLE Dongle Firmware with Hex from Web

In this scenario, choose the hex file from the respective location and update the BLE Dongle firm-
ware with the following steps.
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Figure 3-16.  Open Hex File

4. Ensure the other settings match as shown in Figure 3-16. Click the Program button to start
programming. The status bar at the bottom of the PSoC Programmer window will show the
programming status and the result (Pass/Fail).

Figure 3-17.  Programming Hex File to Dongle

5. After programming is completed successfully, the BLE Dongle firmware is updated and can be
used to connect to the CySmart Central Emulation Tool.

3.7 USB-UART Bridge

The KitProg on both the BLE Pioneer Baseboard and BLE Dongle acts as a USB-UART bridge.
When connected to PC, a device named KitProg USB-UART is available under Ports (COM &
LPT) in the Device Manager. The UART lines between modules and KitProg are hard-wired on
board, with UART_RX assigned to P1_4 and UART_TX assigned to P1_5 on PSoC 4 BLE/PRoC
BLE device. 

COM terminal software, such as Hyperterminal or TeraTerm, can be used to send and receive data.
UART data sent from PSoC 4 BLE/PRoC BLE device on UART_TX line will be received by the
software. Data entered in the software will be received by PSoC 4 BLE/PRoC BLE on UART_RX

line. Refer to Advanced section in CY8CKIT-042 PSoC® 4 Pioneer Kit User Guide for more details.

http://www.cypress.com/?docID=47035
http://www.cypress.com/?docID=47035
http://www.cypress.com/?docID=47035
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Table 3-2 lists the specifications supported by the USB-UART bridge.

3.8 USB-I2C Bridge

The KitProg can function as USB-I2C bridge and communicate with software utility Bridge Control
Panel (BCP). When connected to BCP, the KitProg USB-I2C is available under KitProg\<serial
number> in the BCP. The I2C connection between PSoC 4 BLE/PRoC BLE device and KitProg is
used to transfer data with BCP. The I2C lines on PSoC 4 BLE/PRoC BLE device are P3_4 (SDA)
and P3_5 (SCL), which are hardwired on board to I2C lines of KitProg. The USB-I2C supports I2C
speed of 50 kHz, 100 kHz, 400 kHz and 1 MHz.

BCP is installed as part of PSoC Programmer installation and can be accessed from Start > All Pro-
grams > Cypress > Bridge Control Panel. Refer to Advanced section in CY8CKIT-042 PSoC® 4
Pioneer Kit User Guide for more details.

To use the USB-I2C functionality, select the KitProg\<serial number> in the BCP. On successful
connection, the Connected and Powered status box turn green, as shown in Figure 3-18.

Figure 3-18.  KitProg USB-I2C Connected in Bridge Control Panel

Table 3-2.  Specifications Supported by USB-UART Bridge

Parameter Supported Values

Baud Rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, and 115200

Data Bits 8

Parity None

Stop Bits 1

Flow Control None

File Transfer Protocols sup-
ported

Xmodem, 1K Xmodem, Ymodem, Kermit, and Zmodem (only 
speeds greater than 2400 baud)

http://www.cypress.com/?docID=47035
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3.9 Updating the KitProg Firmware

The KitProg firmware normally does not require any update. If an update is required, then PSoC Pro-
grammer will display a warning message when the kit is connected to it, as shown in Figure 3-19.

Figure 3-19.  Update KitProg

To update the KitProg, go to the Utilities tab on PSoC Programmer and click Upgrade Firmware, as
shown in Figure 3-20.

Figure 3-20.  Update KitProg from PSoC Programmer
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4. Example Projects

This chapter demonstrates the functionality of the PSoC 4 BLE and PRoC BLE devices using the
BLE Pioneer Kit-based example projects. Download and install the kit setup file from the kit web
page. The example projects can be accessed under the Examples and Kits on Start Page of PSoC
Creator. 

4.1 Using Example Projects

Follow these steps to open and use the example projects:

1. Launch PSoC Creator from Start > All Programs > Cypress > PSoC Creator 3.1 > PSoC
Creator 3.1.

2. On the Start Page, under Examples and Kits section, choose Kits > CY8CKIT-042-BLE. A list of
example projects appears, as shown in Figure 4-1. Projects named with the prefix
'PSoC_4_BLE_' work on the BLE Pioneer Kit with the PSoC 4 BLE Module; projects named with
the prefix 'PRoC_BLE_' work on the BLE Pioneer Kit with the PRoC BLE Module.

3. Click on the desired example project.

Figure 4-1.  Open Example Project from PSoC Creator

www.cypress.com/CY8CKIT-042-BLE
www.cypress.com/CY8CKIT-042-BLE
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4. Select the folder where you want to save the project and click OK.

5. Every BLE project use a public address set in the BLE component GUI to advertise and scan,
depending on the role: peripheral or central mode. If multiple kits in close proximity have the
same public address, then wrong devices may be connected or connections may fail. To prevent
this, change the Public address (and preferably Device name) in the BLE component GAP Set-
tings tab as shown in Figure 4-2. Click OK.

Alternatively, you can select the 'Silicon generated' device address by selecting the check box. 
This way, the Bluetooth Device (BD) address is generated using the silicon ID, unique to each 
device. Click OK.

Figure 4-2.  Change BLE Public Address and Name

6. Build the example project by choosing Build > Build <Project Name>, as shown in Figure 4-3. A
.hex file will be generated.

Figure 4-3.  Build Project from PSoC Creator
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7. Connect the BLE Pioneer Baseboard to the PC through USB Mini-B connector J13. Ensure that
the correct module (PSoC 4 BLE or PRoC BLE) is placed on the baseboard, depending on the
project opened.

8. Choose Debug > Program in PSoC Creator, as shown in Figure 4-4.

Figure 4-4.  Program Device in PSoC Creator

9. If the device is not yet acquired, PSoC Creator will open the programming window. Select
KitProg and click the Port Acquire button, as shown in Figure 4-5. 

Note: The serial ID starting with 'BLE' belongs to the BLE Dongle (see Updating BLE Dongle for
CySmart Central Emulation Tool on page 35).

Figure 4-5.  Port Acquire

10.After the device is acquired, it is shown in a structure below the KitProg. Click the Connect but-
ton and then OK to exit the window and start programming, as shown in Figure 4-6.
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Figure 4-6.  Connect Device From PSoC Creator and Program

Note: As stated previously, the BLE Pioneer Kit supports both Cypress BLE devices: PSoC 4 BLE
and PRoC BLE. The description, hardware configurations, and verification method of the Example
projects explained in the following sections are valid for both PSoC 4 BLE and PRoC BLE devices.
Unless explicitly mentioned, the theory and usability for these Example projects should be
considered the same for both the modules.

This document refers to the BLE Pioneer Kits, BLE Dongle, and PC/mobile as Central or Peripheral
devices. A Central device is normally the master and requests/commands data from the Peripheral
device. BLE-enabled phones and PCs are one such example. Peripheral device, on the other hand,
store the actual data and send it to Central device when requested. Examples include BLE-enabled
sensors, proximity beacons, and so on.
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4.2 CapSense Slider and LED

4.2.1 Project Description

This project demonstrates connectivity between the BLE Pioneer Kit (acting as a Peripheral and
GATT server device) and CySmart Central Emulation tool or mobile device running the CySmart
mobile application (acting as a Central and GATT client device). This project demonstrates following:

■ Advertisement with timeout

■ Connection with any Central device

■ Two custom services in single profile

■ Data transfer over BLE custom service using notifications, read, and write

■ Low-power mode implementation for coin-cell operation

The BLE profile in this project consists of two BLE custom services: CapSense and RGB LED. The
CapSense service consists of one custom characteristic, termed as CapSense Slider. The
CapSense slider characteristic is used to send one byte data, ranging from 0 to 100, as notification
to the GATT client device. This data is the finger location read by the CapSense component on the
five-segment slider (CSS1) present on the kit. This characteristics supports notification, which allows
the GATT server to send data to the connected client device whenever new data is available.

The RGB LED service also consists of one custom characteristic, termed as RGB LED Control.
This characteristic supports two operations, read and write, through which the connected GATT cli-
ent device can read data as well as write a new value to the characteristic. This data has four byte
values indicating red, green, blue, and intensity values to control the onboard RGB LED.

These properties for the custom service/characteristics are configured in the BLE component under
the Profiles tab, as shown in Figure 4-7.

Figure 4-7.  Attributes Configuration in BLE Component for custom services
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The project consists of the following files:

■ main.c/.h

These files contain the main function, which is the entry point and execution of the firmware appli-
cation. It also contains function definition for initialization of the system and reading the 
CapSense slider data from the CapSense component.

■ BLEApplications.c/.h

These files contain all the macros and function definitions related to BLE communication and 
operation. It contains the event callback function definition that is registered with the BLE compo-
nent startup and used by the component to send BLE-related events from the BLE stack to the 
application layer for processing. It contains a method to send CapSense notifications to the GATT 
client device and process the Read and Write commands on the RGB LED characteristic by the 
GATT client device. It updates the BLE Connection parameter, which is important for low-power 
mode usage.

■ HandleLowPower.c/.h

These files contain the function to handle low-power mode. This function is continuously called in 
the main loop and is responsible for pushing the BLE hardware block (BLESS) as well as the 
CPU to Deep Sleep mode as much as possible. The wakeup source is either the BLE hardware 
block Link Layer internal timer or the interrupt from the user button press (SW2). This allows for 
very low power mode implementation and operation using a coin cell.

Additionally, the PRoC BLE version of this project consists of the RGB_PRSm.c/.h file, which con-
tains the function to drive the software-based PrISM method and drive the color and intensity on the
RGB LED.

This is the default firmware that comes in the modules shipped with the kit.

Two projects demonstrate this functionality on two different devices: 

■ PSoC_4_BLE_CapSense_Slider_LED works with the PSoC 4 BLE Module.

■ PRoC_BLE_CapSense_Slider_LED works with the PRoC BLE Module. 

The PSoC 4 BLE project implements RGB color and intensity control using the PRiSM component
whereas the PRoC BLE uses the software implementation of the PRiSM mode.
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Figure 4-8.  TopDesign for PSoC_4_BLE_CapSense_Slider_LED Project

Figure 4-9.  TopDesign for PRoC_BLE_CapSense_Slider_LED Project
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4.2.2 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the BLE Pioneer Baseboard. Ensure that the correct module is placed on the
baseboard corresponding to the project being used. PSoC_4_BLE_CapSense_Slider_LED works
with the PSoC 4 BLE Module. PRoC_BLE_CapSense_Slider_LED works with the PRoC BLE
Module.

The pin assignment for this project is in PSoC_4_BLE_CapSense_Slider_LED.cydwr/
PRoC_BLE_CapSense_Slider_LED.cydwr in the Workspace Explorer, as shown in Figure 4-10.

Figure 4-10.  Pin Selection for CapSense Slider and LED Project
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4.2.3 Flow Chart

Figure 4-11 shows the flow chart of the code implemented.

Figure 4-11.  CapSense Slider and LED Project Flow Chart
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4.2.4 Verify Output

The project can be verified by two methods: using the CySmart Central Emulation Tool and BLE
Dongle or using the CySmart mobile application.

4.2.4.1 CySmart Central Emulation Tool

To verify the CapSense and LED project using the CySmart Central Emulation Tool, follow these
steps:

Note: Refer CySmart BLE Host Emulation tool to learn how to use the tool.

1. Connect the BLE Dongle to one of the USB ports on the PC.

2. Start the CySmart Central Emulation Tool on the PC by going to Start > All Programs > Cypress
> CySmart <version> > CySmart <version>. You will see a list of BLE Dongles connected to it.
If no BLE Dongle is found, click Refresh. Select the BLE Dongle and click Connect. 

Figure 4-12.  Connect to BLE Dongle

3. Place module on the BLE Pioneer Kit, depending on the project chosen.

4. Power the BLE Pioneer Kit through the USB connector J13.

5. Program the BLE Pioneer Kit with the CapSense and LED example project. Follow steps in Using
Example Projects on page 41 to program the device.

6. After programming successfully, press the user button (SW2) on the BLE Pioneer kit to start the
advertisement. Advertisement is indicated by a blinking red LED on the baseboard.

Note: The project has an advertisement timeout of 30 seconds after which it returns to Deep 
Sleep. Press SW2 again to restart the advertisement.

7. On the CySmart Central Emulation Tool, click Start Scan to see the list of available BLE
peripheral devices. 

www.cypress.com/cysmart
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8. Double-click the BLE Slider and LED device to connect, or click BLE Slider and LED and then
click Connect.

Figure 4-13.  Connect to BLE Slider and LED Peripheral

9. When connected, the CySmart Central Emulation Tool will display a message for the Update
connection parameters. Select Yes, as shown in Figure 4-14.

Figure 4-14.  Update Connection Parameter Option

Note: If you select No, the project will still work. However, the current consumption will be higher 
due to faster connection interval. 

10.Click Discover All Attributes to find all attributes supported.

Figure 4-15.  Discover All Attributes
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11.Locate the attribute Client Characteristic Configuration descriptor (UUID 0x2902) under
CapSense Slider characteristic (UUID 0xCAA2). Click Read Value to read the existing Client
Characteristic Configuration Descriptor (CCCD) value as shown in Figure 4-16.

Figure 4-16.  Read CCCD for CapSense Slider Characteristic

12.Modify the Value field of CCCD to '01:00' and click Write Value. This enables the notifications on
the CapSense Slider characteristic. 
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Figure 4-17.  Write CCCD to Enable Notifications

13.Swipe your finger on the CapSense slider on the BLE Pioneer kit, as shown in Figure 4-18 and
see the notification values in the CapSense Slider value field, as shown in Figure 4-19. 

Figure 4-18.  CapSense Slider

Figure 4-19.  CapSense Slider Notification Received
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14.To disable notifications, modify the Value field of the Client Characteristic Configuration
descriptor to '00:00' and click Write Value.

Figure 4-20.  Disable Notifications

15.Locate the RGB LED Control characteristic (UUID 0xCBB1). Click Read Value to read the exist-
ing 4-byte onboard RGB LED color information, as shown in Figure 4-21. 

Figure 4-21.  Read RGB LED Control Characteristic Value
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16.Modify the four bytes of data in the Value field and click Write Value. You will see the
corresponding change in the color and intensity of the RGB LED on the BLE Pioneer kit, as
shown in Figure 4-22. The RGB LED will be on for 3 seconds before switching off to conserve
power.

Note: If the BLE Pioneer kit is powered from a coin cell and not the USB Vbus, then the color
mixing and intensity will vary. This is because the coin cell provides a lower driving voltage for
RGB LEDs.

Figure 4-22.  Write RGB LED Control Characteristic Value

Figure 4-23.  RGB LED Control with PSoC 4 BLE Module and PRoC BLE Module
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17.To disconnect from the device, click Disconnect, as shown in Figure 4-24.

Figure 4-24.  Disconnect from the Device

18.To connect to this Peripheral again, restart advertising by pressing the user button (SW2) on the
BLE Pioneer Kit. Advertising is indicated by the blinking red LED.

4.2.4.2 CySmart Mobile Application

To verify the CapSense and LED project using the CySmart mobile application (see CySmart Mobile
Application on page 112), follow these steps:

1. Plug the desired module on the BLE Pioneer Baseboard. 

2. Connect the BLE Pioneer Kit into the PC using the J13 USB connector.

3. Program the kit with the CapSense and LED example projects. See Using Example Projects on
page 41 for programming instructions.

4. Press the user button (SW2) on the BLE Pioneer Kit to start the advertisement. This is indicated
by the blinking red LED on the BLE Pioneer Kit.

5. Open the application on the mobile device. If Bluetooth is not enabled on the device, the
application will ask to enable it.

6. After Bluetooth is enabled, the CySmart mobile application will automatically search for available
Peripherals and list them. Select the BLE Slider and LED Peripheral as shown in Figure 4-25.
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Figure 4-25.  BLE Slider and LED Peripheral

7. When connected, the CySmart mobile application will list the supported profiles by the Peripher-
als. Scroll and select the CapSense icon, as shown in Figure 4-26.

Figure 4-26.  CapSense Service Page

8. Swipe your finger on the CapSense slider on the BLE Pioneer Kit and see a similar response on
the CapSense page in the CySmart application (Figure 4-27).
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Figure 4-27.  CapSense Slider

9. Press the back button to return to the service selection page. Scroll and tap on the RGB LED ser-
vice.

10.On the RGB LED service page, swipe over the color gamut to see a similar color response on the
BLE Pioneer Kit RGB LED. The slider below the color gamut controls the intensity of the RGB
LED color. The RGB LED will be on for 3 seconds before switching off. This is done to conserve
power. 

Figure 4-28.  RGB LED Control with CySmart mobile application 
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11.To disconnect from the BLE Pioneer Kit, return to the CySmart mobile application home screen
by pressing the back button.

12.To reconnect to the peripheral, press the user button (SW2) on the BLE Pioneer Kit again and
then scan for devices using CySmart mobile application.

4.3 CapSense Proximity

4.3.1 Project Description

This project demonstrates connectivity between the BLE Pioneer Kit (acting as a Peripheral and
GATT server device) and the CySmart Central Emulation Tool or mobile device running the CySmart
mobile application (acting as a Central and GATT client device). This project demonstrates the
following:

■ Advertisement with timeout

■ Connection with any Central device

■ One custom service

■ Data transfer over BLE custom service using notifications

■ Low-power mode implementation for coin cell operation

The BLE profile in this project consists of a single BLE custom service, called CapSense. The
CapSense service consists of a custom characteristic, termed as CapSense Proximity. The
CapSense proximity characteristic is used to send one byte data, ranging from 0 to 255, as
notification to the GATT client device. This data is the difference count read by the CapSense
component on the one-wire proximity sensor (J14) connected on the kit. This characteristics
supports notification, which allows the GATT server to send data to the connected GATT client
device whenever new data is available.

The properties for the custom attributes are configured in the BLE component under the Profiles tab,
as shown in Figure 4-29.
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Figure 4-29.  Attributes Configuration in BLE Component for CapSense Proximity

The project consists the following files:

■ main.c/.h

These files contain the main function, which is the entry point and execution of the firmware appli-
cation. It contains function definition for initialization of the system and reading the CapSense 
proximity data from the CapSense component.

■ BLEApplications.c/.h

These files contain all the macros and function definitions related to BLE communication and 
operation. It contains the event callback function definition that is registered with the BLE compo-
nent startup and used by the component to send BLE-related event from the BLE stack to the 
application layer for processing. It contains a method to send CapSense notifications to the GATT 
client device. It updates the BLE Connection parameter, which is important for low-power mode 
usage.

■ HandleLowPower.c/.h

These files contain the function to handle low-power mode. This function is continuously called in 
the main loop and is responsible for pushing the BLE hardware block (BLESS) as well as the 
CPU to Deep Sleep mode as much as possible. The wakeup source is either the BLE hardware 
block Link Layer internal timer or the interrupt from the user button press (SW2). This allows for 
very low-power mode implementation and operation using a coin cell.

The red LED is used as the status LED and provides visual confirmation on advertising or
connection states. A blinking red LED indicates advertising state.

Two projects demonstrate this functionality on two different devices:

■ PSoC_4_BLE_CapSense_Proximity works with the PSoC 4 BLE Module. 

■ PRoC_BLE_CapSense_Proximity works with the PRoC BLE Module. 
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Figure 4-30.  Top Design for PSoC_4_BLE_CapSense_Proximity Project

Figure 4-31.  Top Design for PRoC_BLE_CapSense_Proximity Project
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4.3.2 Hardware Connections

■ Ensure that the correct module is placed on the baseboard corresponding to the project being
used. PSoC_4_BLE_CapSense_Proximity works with the PSoC 4 BLE Module.
PRoC_BLE_CapSense_Proximity works with the PRoC BLE Module.

■ Connect a five-inch wire (provided as part of this kit) to the proximity connector J14 on the
baseboard. Loop the wire as shown in Figure 4-32.

Note: Ensure that the proximity sensor loop wire is kept away as much as possible from the BLE
antenna on the modules.

Figure 4-32.  Proximity Sensor Connection on BLE Pioneer Kit with PSoC 4 BLE Module

Figure 4-33.  Proximity Sensor Connection on BLE Pioneer Kit with PRoC BLE Module

The pin assignment for this project is in PSoC_4_BLE_CapSense_Proximity.cydwr/
PRoC_BLE_CapSense_Proximity.cydwr in the Workspace Explorer, as shown in Figure 4-34.

Figure 4-34.  Pin Selection for CapSense Proximity Project
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4.3.3 Flow Chart

Figure 4-35 shows the flow chart of code implemented.

Figure 4-35.  CapSense Proximity Project Flow Chart
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4.3.4 Verify Output

The project can be verified by two methods: using the CySmart Central Emulation Tool and BLE
Dongle or using the CySmart iOS/Android app.

4.3.4.1 CySmart Central Emulation Tool

To verify the CapSense proximity project using the CySmart Central Emulation Tool, follow these
steps:

Note: Refer CySmart BLE Host Emulation tool to learn how to use the tool.

1. Connect the BLE Dongle to one of the USB ports on the PC.

2. Start the CySmart Central Emulation Tool on the PC by going to Start > All Programs > Cypress
> CySmart <version> > CySmart <version>. You will see a list of dongles connected to it. If no
BLE Dongle is found, click Refresh. Select the BLE Dongle and click Connect.

Figure 4-36.  Connect to BLE Dongle

3. Connect a five-inch wire (included in the kit) to the proximity sensor connector J14 and make a
loop of it.

4. Power the BLE Pioneer Kit through the USB connector J13.

5. Program the BLE Pioneer Kit with the CapSense proximity example project. Follow the steps in
Using Example Projects on page 41 to program the device.

6. After programming successfully, press the user button (SW2) on the BLE Pioneer kit to start the
advertisement. This is indicated by a blinking red LED on the baseboard.
Note: The project has an advertisement timeout of 30 seconds after which it returns to Deep
Sleep. Press SW2 again to restart the advertisement.

7. On the CySmart Central Emulation Tool, click Start Scan to see the list of available Peripheral
devices. 

www.cypress.com/cysmart
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Figure 4-37.  Start Scanning

8. Double-click CapSense Proximity to connect or click Connect to connect to the BLE Pioneer
Kit. 

Figure 4-38.  Connect to CapSense Proximity Peripheral

9. When connected, the CySmart Central Emulation Tool will display a message for the Update 
connection parameters. Select Yes, as shown in Figure 4-39.

Figure 4-39.  Update Connection Parameter Option

Note: If you select No, the project will still work. However, the current consumption will be higher 
due to faster connection interval.
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10.Click Discover All Attributes to find all attributes supported by the Peripheral.

Figure 4-40.  Discover All Attributes

11.When all the attributes are listed, locate the Client Characteristic Configuration descriptor
(UUID 0x2902) under CapSense Proximity characteristic (UUID 0xCAA1). Click Read Value to
read the existing CCCD value as shown in Figure 4-41.

Figure 4-41.  Read CapSense Proximity CCCD

12.Modify the Value field to '01:00' and click Write Value. This enables the notifications on the
CapSense Proximity characteristic. 
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Figure 4-42.  Write CCCD to Enable Notifications

13.Bring your hand closer to the proximity sensor on the BLE Pioneer Kit, as shown in Figure 4-43
and observe the value changing in the characteristic value field, as shown in Figure 4-44. 

Figure 4-43.  CapSense Proximity Sensing with PSoC 4 BLE Module

Figure 4-44.  CapSense Proximity Notification Received
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14.Modify the Value field of the Client Characteristic Configuration descriptor to '00:00' to disable
notifications.

15.To disconnect from the device, click Disconnect, as shown in Figure 4-45.

Figure 4-45.  Disconnect from the Device

16.Press user button (SW2) to wake up from sleep and restart the advertisement for the next
connection.

4.3.4.2 CySmart Mobile Application

To learn how to use the CySmart mobile application, see CySmart Mobile Application on page 112 or
the app user guide.

To verify the CapSense proximity project using the CySmart mobile application, follow these steps:

1. Place the desired module on BLE Pioneer Baseboard. 

2. Connect the five-inch wire as a loop to the proximity connector J14 on the baseboard.

3. Plug the BLE Pioneer Kit into the PC, using the J13 USB connector.

4. Program the kit with the CapSense proximity example project. Follow steps in Using Example
Projects on page 41 to program the device.

5. Press the user button (SW2) on the BLE Pioneer Kit to start the advertisement.

6. Open the CySmart mobile application on the mobile device. If Bluetooth is not enabled on the
device, the app will ask to enable it.

7. The app will automatically search for available Peripherals and list them. Select the CapSense
Proximity Peripheral, as shown in Figure 4-46.
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Figure 4-46.  Connect to CapSense Proximity Peripheral

8. When connected, the app will list the services supported by the Peripherals. Scroll and select the
CapSense service.

9. When the CapSense service page opens, bring your hand near the sensor wire on the BLE
Pioneer Kit and see a similar response in the app as a bar graph, as shown in Figure 4-47.

Figure 4-47.  CapSense Proximity Sensing with PSoC 4 BLE Module

10.To disconnect from the BLE Pioneer Kit, return to the device selection screen on the CySmart
mobile application.

11.To reconnect to the Peripheral, press the user button (SW2) on the BLE Pioneer Kit to restart the
advertisement and scan for the device in the CySmart mobile application.
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4.4 BLE Central Mode

4.4.1 Project Description

The BLE projects described above have been functioning as Peripheral devices. This means that the
firmware role was set to be a Peripheral and GATT server; another device such as the CySmart
Central Emulation Tool or CySmart mobile application will connect to it and collect the data.

This example project demonstrates the Central and GATT client mode where it will scan for a Periph-
eral device, connect to it, and send commands. In this project, the BLE Pioneer Kit scans and auto-
connects to a particular Peripheral device supporting Immediate Alert Service (IAS). Whenever the
Peripheral with a predetermined public address is found, a connection request is sent followed by
discovering the attributes. When the discovery is over, you can send one of the three alert levels to
the Peripheral device over the IAS. This is done by pressing the SW2 button on the BLE Pioneer Kit
and cycling through the alert levels.

The BLE Central project supports low-power mode operation, where the firmware supports BLE
Hardware Block and CPU Deep Sleep mode whenever possible. The system remains in Deep Sleep
when disconnected. Press SW2 to wake up the system and start scanning (blinking blue LED). The
scanning timeout interval is set to 30 seconds. If the particular Peripheral device is found advertising
before timeout, a connection is made (blue LED always ON). If no such device is found, then the
system stops scanning and returns to Deep Sleep mode (LED OFF). Press SW2 again to wake the
system and restart scanning.

To aid in evaluation, the Peripheral project with the particular public address is provided in the same
workspace. This Peripheral project supports IAS and has fixed public address that the Central
device will recognize and auto-connect to. This Peripheral project should be programmed on the
BLE Dongle and powered through the USB port of PC. The received alert levels (No, Mid, and High
alert) on the BLE Dongle are represented by different LED status. No Alert is represented by LED
OFF, Mid Alert by blinking LED, and High Alert with LED always ON. Upon each successive button
press on the BLE Pioneer Kit, the LED state on the BLE Dongle changes in a circular fashion.

Two projects demonstrate the BLE Central functionality on the two devices:

■ PSoC_4_BLE_Central_IAS works with the PSoC 4 BLE Module. 

■ PRoC_BLE_Central_IAS works with the PRoC BLE Module. 

Additionally, the BLE_Dongle_Peripheral_IAS project is to be programmed on the BLE Dongle.
This project is present in both the PSoC_4_BLE_Central_IAS and the PRoC_BLE_Central_IAS
workspace and can be used to program the BLE Dongle separately. 

Note: If the BLE Dongle is programmed with the BLE_Dongle_Peripheral_IAS example, it will not
work with the CySmart PC utility. Reprogram the BLE Dongle with the CySmart firmware according
to Updating BLE Dongle for CySmart Central Emulation Tool on page 35 to use the CySmart Central
Emulation Tool.
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Figure 4-48.  PSoC_4_BLE_Central_IAS TopDesign

Figure 4-49.  PRoC_BLE_Central_IAS TopDesign



72 CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *B

Example Projects

Figure 4-50.  BLE_Dongle_Peripheral_IAS TopDesign

4.4.2 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the BLE Pioneer Baseboard. 

Ensure that the correct module is placed on the BLE Pioneer Baseboard corresponding to the proj-
ect being used. PSoC_4_BLE_Central_IAS works with the PSoC 4 BLE Module.
PRoC_BLE_Central_IAS works with the PRoC BLE Module. BLE_Dongle_Peripheral_IAS is the
common project for both workspaces and programs the BLE Dongle with Peripheral mode firmware.

The pin assignment for this project is in PSoC_4_BLE_Central_IAS.cydwr/
PRoC_BLE_Central_IAS.cydwr in the Workspace Explorer, as shown in Figure 4-51.

Figure 4-51.  Pin Selection for BLE IAS Central Example Project

Similarly, the pin assignment for the BLE Dongle Peripheral project is in
BLE_Dongle_Peripheral_IAS.cydwr in the Workspace Explorer as shown in Figure 4-52.

Figure 4-52.  Pin Selection for BLE IAS Peripheral Example Project
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4.4.3 Flow Chart

Figure 4-53 shows the flow chart for the IAS GATT client mode example project.

Figure 4-53.  IAS GATT client mode Flow Chart
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Figure 4-54 shows the flow chart for the IAS GATT server mode example project.

Figure 4-54.  IAS GATT server mode Flow Chart

4.4.4 Verify Output

1. Connect the BLE Dongle to one of the USB ports on the PC.

Figure 4-55.  Connect BLE Dongle to USB Port
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2. In the PSoC Creator Workspace Explorer, right-click on the BLE_Dongle_Peripheral_IAS
project and select Set As Active Project, as shown in Figure 4-56.

Figure 4-56.  Set Dongle Peripheral Project as Active

3. Program the BLE Dongle with the BLE_Dongle_Peripheral_IAS project described in Using
Example Projects on page 41.

Note: Do not update the public device address (inside the BLE component) for the
BLE_Dongle_Peripheral_IAS example project. Changing the BLE_Dongle_Peripheral_IAS
example project public address will lead to no connection with the BLE Central device on the BLE
Pioneer kit.

4. Power the BLE Pioneer Kit through USB connector J13.

5. In the Workspace Explorer, right-click on the PSoC_4_BLE_Central_IAS project and select Set
As Active Project, as shown in Figure 4-57.
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Figure 4-57.  Set Central IAS Project as Active

6. Program the BLE Pioneer Kit with either the PSoC_4_BLE_Central_IAS or the
PRoC_BLE_Central_IAS project, depending on the module placed on the BLE Pioneer Kit.

7. Press button SW2 on the BLE Pioneer Kit to wake the system and start scanning. Scanning is
indicated by a blinking LED.

8. Wait for the BLE connection between the BLE Dongle and the BLE Pioneer Kit. The connection
success status is indicated on the baseboard in the following three stages:

a. Fast blinking blue LED represents scanning mode. During this mode, the BLE Pioneer Kit is
scanning for peripheral devices.

b. Slow blinking blue LED represents discovery mode. During this mode, the BLE Pioneer Kit
has found the BLE Dongle Peripheral device and has started the connection procedure.

c. The blue LED remains on, representing the connected mode. This mode indicates that the
Peripheral device has been connected and the application can now send alert levels.

9. Press button SW2 on the BLE Pioneer Kit to send the next alert level to the BLE Dongle. The
alert level will rotate from No Alert to Mid Alert to High Alert. 
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Figure 4-58.  User Button on BLE Pioneer Kit with PSoC 4 BLE Module

10.Check if the LED behavior changes for each alert notification on the BLE Dongle according to the
following table:

Note: To revert the CySmart functionality to the dongle, program the dongle hex file, as described in
Updating BLE Dongle for CySmart Central Emulation Tool on page 35.

4.5 BLE Dongle and LED Control

4.5.1 Project Description

This firmware supports the CySmart debug tool (see CySmart Mobile Application on page 112) by
acting as the BLE host emulator. This is the default firmware that comes in the BLE Dongle shipped
with the kit.

This project additionally demonstrates LED brightness control via a custom BLE profile, which works
with the CapSense slider example explained in CapSense Slider and LED on page 45. 

The device will scan for the Peripheral acting as a CapSense Slider and LED device, and connect to
it automatically. This is achieved by filtering the advertisement packets for the CapSense Slider
service data. Then, it will enable slider notifications and process the received notifications.
Whenever CapSense detects activity, it will notify the finger location to the BLE Dongle; it will update
the LED brightness using PWM.

The custom GATT client LED control will be stopped if the CySmart Central Emulation Tool acquires
the dongle. The dongle will enter the CySmart emulator mode, in which it will process all BLE
commands as triggered by the user via the tool. The project uses custom command/event protocol
to exchange data between the CySmart Central Emulation Tool and the BLE device via a USB-CDC

Alert Level LED State

No Alert LED Off

Mild Alert LED Blinking

High Alert LED On
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interface. It uses the Cypress USB-UART bridge functionality from the PSoC 5LP-based KitProg
module.

Note: This project is meant only for the PRoC BLE device and works on the dongle hardware.

Figure 4-59.  Top Design for BLE_Dongle_CySmart Project 

4.5.2 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the BLE Dongle.

The pin assignment for this project is in BLE_Dongle_CySmart.cydwr in the Workspace Explorer,
as shown in Figure 4-60.

Figure 4-60.  Pin Selection for BLE Dongle Project
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4.5.3 Flow Chart

Figure 4-61.  Flow Chart for BLE_Dongle_CySmart Project 
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4.5.4 Verify Output

This project will be used whenever the CySmart Central Emulation Tool (see CySmart Mobile Appli-
cation on page 112) is invoked for testing other example projects. In addition, the LED control opera-
tion can be verified as follows.

1. Power the BLE Pioneer kit through the USB connector J13.

2. Program the BLE Pioneer kit with the CapSense and LED example project described in
CapSense Slider and LED on page 45.

3. Connect the BLE Dongle to one of the USB ports on the PC.

4. Program the BLE Dongle with the BLE_Dongle_CySmart project. See Using Example Projects
on page 41 for programming instructions.

5. Press the user button SW2 on both the BLE Dongle and the BLE Pioneer Kit. The BLE Dongle
will start scanning and the BLE Pioneer Kit will start advertising.

6. Wait for the BLE connection between the BLE Dongle and the BLE Pioneer Baseboard. The con-
nection success status will be indicated by a 3-second ON state of the red LED followed by the
OFF state on the BLE Pioneer Baseboard.

7. Swipe your finger on the CapSense slider and check the LED brightness variation on the BLE
Dongle.

4.6 Direct Test Mode (DTM)

4.6.1 Project Description

Bluetooth Core specification (v4.0 and later), Volume 6, Part F defines Direct Test Mode (DTM) as a
method to test the BLE PHY layer and provide a report back to the tester. It uses one of the two
methods, over Host Controller Interface (HCI) or through a two-wire UART interface.

Device under test (DUT) is the BLE system that is to be tested (for example, BLE Pioneer Kit). With
DTM, the RF performance of the BLE system can be verified during development or in production
line. The environment consists of the DUT and a tester. The tester has two parts; the upper tester
sends commands through one of the two methods (HCI or two-wire UART) and the lower tester per-
forms the corresponding action over the RF link. The tester compares the command sent over HCI
and the response received over RF, and provides a result of the performance.

Figure 4-62.  Direct Test Mode (DTM) Setup

The BLE Component allows configuring the device in DTM by enabling the HCI. The appropriate
response to commands from the tester are performed by the BLE protocol stack and does not
involve separate application handling. The only task is to start the BLE Component and call the API
to process the events.

DUT

Upper 
Tester

Lower 
Tester

RF (2.4 GHz)

HCI/UART

https://developer.bluetooth.org/TechnologyOverview/Pages/core-specification.aspx
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The HCI is enabled in the BLE Component under the General Settings. Note that when the HCI
mode is selected, all other tabs are hidden and cannot be configured. This is because in HCI mode,
there are no upper layer processes. On enabling HCI mode in the components, the components
automatically reserves a UART block to allow communication between the tester and BLE stack.
The UART exposes the pins that can be assigned in <project.cydwr> file under Pins tab. The only
option to be configured for HCI mode is the baud rate and the pins for communication with the tester.

Figure 4-63.  HCI Mode in BLE Component

Many companies develop BLE testers for Direct Test Mode. It is also possible to create PC-based
software tools that will send HCI commands over serial communication links.

For PC-based software, the serial communication link is the COM port, which is enumerated by Kit-
Prog on PSoC 5LP of the BLE Pioneer kit. In such a case, the UART pins in PSoC 4 BLE/PRoC BLE
should be assigned to P1_4 and P1_5. These pins are hardwired to pins on PSoC 5LP and allows
USB-UART data communication between the PC-based software and the BLE device.

For external BLE testers, the serial communication is mostly over the RS232. To test with this
system, an external RS232 voltage translator is required, such as Digilent's Pmod RS232. This
translator will modify the signal level of the serial communication between the BLE device and the
RS232 port on the tester. The UART pins of the BLE device can be assigned to P0_0 and P0_1 and
the header J5 can be used to connect to the RS232 translator.

http://www.digilentinc.com/Products/Detail.cfm?Prod=PMOD-RS232
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Figure 4-64.  J5 Header to Interface RS232 Translator

4.6.2 Hardware Connection

For DTM test mode, it is recommended to use SMA connectors and connect the tester and DUT
using a SMA to SMA connector cable. This ensures that there is minimum interference to RF
communication between the DUT and tester, and the performance measured is the true RF
performance of the device. The BLE Pioneer Kit module with SMA connector (CY8CKIT-141 PSoC 4
BLE) is available separately and can be ordered from the Cypress web page.

Four UART pins are exposed when HCI mode is selected in the BLE Component. These pins should
be assigned to allow communication with the external tester. The connection depends on the tester
being used.

If the tester is a PC-based software and communicated with HCI over serial link, then the onboard
PSoC 5LP on the BLE Pioneer Kit can act as the USB-UART bridge. The KitProg on the PSoC 5LP
enumerates as a USB-UART interface and opens a COM port in the PC. This COM port is then used
by the software tool to communicate commands to the BLE device. In this case, the UART pins
should be assigned as follows. 

The UART for HCI communication exposes hardware flow control lines CTS and RTS. They can
either be connected to the hardware control lines of the tester or CTS connected to ground for oper-
ation without hardware flow control.

If the tester is an external hardware tester (CBT), then connect any of the RS232 voltage translators
to header J5 on the BLE Pioneer Kit. The UART pins should be assigned as follows.

Table 4-1.  UART Pin Assignment for PC Software Tester

UART Pins Pin Assigned

RX P1_4

TX P1_5

RTS P1_6

CTS P1_7

www.cypress.com/cy8ckit-141
https://digilentinc.com/Products/Detail.cfm?NavPath=2,401,463&Prod=PMOD-RS232
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4.6.3 Verify Output

1. Connect the BLE Pioneer Kit through the USB connector J13.

2. Program the BLE Pioneer Kit with the PSoC_4_BLE_DTM or PRoC_BLE_DTM project, depend-
ing on the module used (PSoC 4 BLE or PRoC BLE), as described in Using Example Projects on 
page 41. Programming should complete successfully.

3. Connect the Serial link, UART or RS232 to the tester.

4. On the software tool for tester, configure the UART communication with the correct COM port and 
baud rate, as set in the BLE Component.

5. Start the test. The tool will generate the report after the end of the test. This depends on the tes-
ter/tool being used. 

Table 4-2.  UART Pin Assignment for RS232 Voltage Translator

UART Pins Pin Assigned

RX P0_0

TX P0_1

RTS P0_2

CTS P0_3
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5. Hardware

This chapter describes the contents of the BLE Pioneer Kit hardware and its different blocks, such as
the power block, USB connection, Arduino-compatible headers, module connectors, and CapSense
slider.

5.1 BLE Pioneer Baseboard

5.1.1 PSoC 5LP

An onboard PSoC 5LP contains KitProg which is used to program and debug the BLE device. The
PSoC 5LP connects to the USB port of the PC through a USB Mini-B connector and to the SWD
interface of the BLE device. PSoC 5LP is a true system-level solution providing MCU, memory,
analog, and digital peripheral functions in a single chip. The CY8C58LPxx family offers a modern
method of signal acquisition, signal processing, and control with high accuracy, high bandwidth, and
high flexibility. The analog capability spans the range from thermocouples (near DC voltages) to
ultrasonic signals.

For more information, visit the PSoC 5LP web page.

See Serial Interconnection between KitProg and Module on page 101 for more details.

5.1.2 Power System

The power supply system on BLE Pioneer Baseboard is versatile, allowing the input supply to come
from the following sources:

■ 5-V power from onboard USB connector

■ 5-V to 12-V VIN power from Arduino power header (J1)

■ 3-V from CR2032 coin cell

http://www.cypress.com/PSoC5LP/
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An adjustable LDO is used to output three different voltage levels (1.9 V, 3.3 V, and 5 V) to power the
module. These voltages are selected with the J16 jumper, as shown in Figure 5-1.

Figure 5-1.  Schematics and Board Highlight of LDO and Power Selection Jumper

The input to the LDO can come from either the USB, the VIN pin in the Arduino header J1 or header
J9.

Note: The typical dropout voltage of the selected LDO is 0.3 V at 500-mA output current. This gives
a minimum output of 4.6 V from the input voltage of 5 V from the VBUS. This drop also takes into
account the voltage drop across the Schottky diode connected at the output of the LDO to protect
against voltage applied at the output terminal of the regulator. 
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The BLE Pioneer Baseboard also contains a CR2032 coin cell holder to power it using a coin cell, as
shown in Figure 5-2.

Figure 5-2.  Schematics and Board Highlight of Coin Cell Holder

5.1.2.1 Protection Circuits

The power supply rail has reverse-voltage, overvoltage, short circuits, and excess current protection
features, as shown in Figure 5-3.

Figure 5-3.  Power Supply Block Diagram With Protection Circuits

■ A PTC resettable fuse is connected to protect the computer's USB ports from shorts and
overcurrent.

■ ORing diodes prevent damage to components when the BLE Pioneer Baseboard is powered
from different voltage sources at the same time.

■ ESD protection is provided for the USB Mini-B connector.
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■ A MOSFET-based protection circuit is provided for overvoltage and reverse-voltage protection for
the 3.3-V rail from J1.5, as shown in Figure 5-4. 

Figure 5-4.  Schematics and Board Highlight of MOSFET Protection Circuit for 3.3-V rail from J1.5
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5.1.2.2 Current Measurement Jumper

To demonstrate the low power consumption of PSoC 4 BLE/PRoC BLE Module, a two-pin header
(J15) is populated in series with the power supply to the module. This can be used to measure cur-
rent using an ammeter without the need to desolder any components from the BLE Pioneer Base-
board, as shown in Figure 5-5. 

Figure 5-5.  Schematics and Board Highlight of Current Measurement Jumper
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The following methods are supported for measuring the current consumption of the module. 

■ When the BLE Pioneer Baseboard is powered through the USB port (J13), remove jumper J15
and connect an ammeter, as shown in Figure 5-6.

Figure 5-6.  Current Measurement when Powered from USB Port
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■ When the BLE Pioneer Baseboard is powered from an external voltage supply, remove the USB
cable from J13. Connect the positive terminal of the external voltage supply to the positive termi-
nal of the ammeter and the negative terminal of the ammeter to the upper pin of J15. Connect the
negative terminal of the external voltage supply to and GND pin on board. Figure 5-7 shows the
required connections.

Figure 5-7.  Current Measurement when Powered Separately

To measure the power consumption of only module with coin cell, connect the coin cell directly to the
modules, as shown in Figure 5-8. The BLE Pioneer Baseboard is designed with additional circuits to
protect the BLE device and the F-RAM in Arduino environment. Note that power consumption
measurements on the BLE Pioneer Baseboard will also include the power consumed by these
additional circuits. 

Connect the positive terminal of the coin cell to pin J2.2 and negative terminal to pin J2.4 using
wires.

VOLTAGE 
SOURCE

-                +
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Figure 5-8.  Powering the module using a Coin Cell

5.1.3 Programming Interface

The BLE Pioneer Kit allows you to program and debug the PSoC 4 BLE/PRoC BLE in two ways:

■ Using the onboard KitProg 

■ Using a CY8CKIT-002 MiniProg3 Programmer and Debugger 

5.1.4 Expansion Connectors

5.1.4.1 Arduino Compatible Headers (J1, J2, J3, J4, and J12-unpopulated)

The BLE Pioneer Kit has five Arduino compatible headers: J1, J2, J3, J4, and J12, as shown in
Figure 5-9. You can develop applications based on the Arduino shield's hardware.

Figure 5-9.  Arduino Headers

The J1 header contains I/O pins for reset, I/O reference voltage (IOREF), and power supply line. The
J2 header is an analog port that contains I/O pins for SAR ADC, comparator, and Op-amp. The J3
header is primarily a digital port that contains I/O pins for PWM, I2C, SPI, and analog reference. The
J4 header is also a digital port that contains I/O pins for UART and PWM. The J12 header is an
Arduino ICSP compatible header for the SPI interface and is not populated. Refer to the “No Load
Components” section of Bill of Materials (BOM) on page 133 for the header part number. 

Note: Take care when powering the Arduino shields via Arduino-compatible power header (J1). The
V3.3 pin will output 5 V when the board is powered from USB/VIN and the system power supply
jumper (J16) is set to 5 V operation. 
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Additional Functionality of Header J2

The J2 header is a 6×2 header that supports Arduino shields. The Port 2 and Port 3 pins of PSoC 4
BLE and PRoC BLE are brought to this header. The Port 2 pins also connect to the onboard
CapSense slider through 560-ohm resistors. When the CapSense feature is not used, remove these
resistors to help ensure better performance with these pins. 

5.1.4.2 PMod Connector - Digilent Pmod Compatible (J5-unpopulated)

This port supports Digilent Pmod modules (see Figure 5-10). Pmods are small I/O interfaces that
connect with the embedded control boards through either 6- or 12-pin connectors. The BLE Pioneer
Kit supports the 6-pin Pmod type 2 (SPI) interface. For Digilent Pmod cards, go to
www.digilentinc.com.

This header is not populated on the BLE Pioneer Baseboard. You must populate this header before
connecting the Pmod daughter cards. Refer to the “No Load Components” section of Bill of Materials
(BOM) on page 133 for the header part number.

Figure 5-10.  Schematics and Board Highlight of PMod Connector

Digilent® 

PmodTM - 
compatible I/O 
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www.digilentinc.com
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5.1.4.3 PSoC 5LP GPIO Header (J8)

An 8×2 header is provided on the BLE Pioneer Baseboard to pull out several pins of PSoC 5LP to
support advanced features such as a low-speed oscilloscope and a low-speed digital logic analyzer
(see Figure 5-11). This header also contains the USB-Serial interface pins that can be used when
these pins are not accessible on the Arduino headers because a shield is connected.

Note: You can use PSoC 5LP for your own custom firmware. 

Figure 5-11.  Schematics and Board Highlight of PSoC 5LP GPIO Expansion Header

PSoC 5LP GPIO Expansion Header

USB-Serial Bridge Connections

P5LP12_6 ------------- UART RX
P5LP12_7 ------------- UART TX
P5LP12_0 ------------- SPI SCLK / I2C SCL
P5LP12_1 ------------- SPI MISO / I2C SDA 
P5LP12_5 ------------- SPI MOSI 
P5LP2_5  ------------- SPI SSEL

P5LP12_7P5LP12_6
P5LP3_6 P5LP3_7

P5LP0_0
P5LP1_2

P5LP3_5P5LP3_4

P5LP3_0

P5LP0_1

P5LP12_1
P5LP12_5P5LP12_0

P5LP2_5

VDD

SPI_MOSI
SPI_SSEL

UART TXUART RX

J8

8x2 RECPT

1
1

2
2

3
3

4
4

5
5

6
6

7
7

8
8

10
10

9
9

12
12

11
11

14
14

13
13

16
16

15
15



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *B 95

Hardware

5.1.5 USB Mini-B Connector

The PSoC 5LP connects to the USB port of a PC through a Mini-B connector (see Figure 5-12),
which can also be used to power the BLE Pineer Baseboard. A resettable polyfuse is used to protect
the computer's USB ports from shorts and overcurrent. If more than 500 mA is drawn from the USB
port, the fuse will automatically break the connection until the short or overload is removed.

Figure 5-12.  Schematics and Board Highlight of USB Mini-B Connector
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5.1.6 CapSense Circuit

5.1.6.1 CapSense Slider

The BLE Pioneer Kit has a five-segment linear capacitive touch slider, which is connected to the
PSoC 4 BLE/PRoC BLE Module pins (see Figure 5-13). The CMOD and CTANK capacitors are
required for CapSense functionality and are provided on the modules (see Module Board on
page 103). A 2.2-nF capacitor is present on the CMOD pin, P4[0], for CapSense operation. BLE
Pioneer Kit also supports CapSense designs that enable waterproofing. The connection of the shield
to the pin or to ground is made by resistors R12 and R13, respectively. By default, R13 is mounted
on the BLE Pioneer Baseboard, which connects the shield to ground. Populate R12 and remove R13
when evaluating waterproofing designs, which will connect the shield to the designated pin, P1[6].

Figure 5-13.  Schematics and Board Highlight of CapSense Slider and Shield Setting

5.1.6.2 Proximity Header

The BLE Pioneer Baseboard contains a header (J14) for CapSense proximity wire connection (see
Figure 5-14).
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Figure 5-14.  Schematics and Board Highlight of Proximity Header

5.1.7 BLE Pioneer Baseboard LEDs

The BLE Pioneer Baseboard has three LEDs. A green LED (LED2) indicates the status of the pro-
grammer. An amber LED (LED1) indicates the status of power supplied to the board. The BLE Pio-
neer Kit also has a general-purpose tricolor LED (LED3) for user applications. These are connected
to P2_6 (Red LED), P3_6 (Green LED) and P3_7 (Blue LED). Figure 5-15 and Figure 5-16 show the
schematics of these LEDs. 

Figure 5-15.  Schematics of Status and Power LED
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Figure 5-16.  Schematics and Board Highlight of RGB LED
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5.1.8 Push Buttons

The BLE Pioneer Baseboard contains a reset push button and a user push button, as shown in
Figure 5-17. The reset button is connected to the XRES pin of BLE device and is used to reset it.
The user button is connected to P2[7] of the BLE device. Both the push buttons connect to ground
on activation (active low).

Figure 5-17.  Schematics and Board Highlight of Reset Button and User Push Button
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5.1.9 Cypress Ferroelectric RAM (F-RAM)

The BLE Pioneer Baseboard contains an F-RAM device (FM24V10-G) (see Figure 5-18) that can be
accessed through I2C lines P5[0] and P5[1] of the PSoC 4 BLE/PRoC BLE Module. The F-RAM is 1-
Mbit (128 KB) with an I2C speed up to 1 Mbps. The I2C slave address of the F-RAM device is seven
bits wide, and the LSB two bits are configurable through physical pins and are hardwired to 00 on the
board. By default, the address of the F-RAM device used on the BLE Pioneer Baseboard is 0x50.
This address can be modified by changing the R32/R36 and R33/R37 pairs. The operating voltage
range of the F-RAM is between 2 V and 3.6 V. To prevent the application of 5 V from the adjustable
LDO regulator on the BLE Pioneer Baseboard, a MOSFET based protection circuit similar to the one
used for the 3.3-V rail is connected between the output of the regulator and the VDD pin of the F-
RAM. The protection circuit cuts off the power to the F-RAM when the output of the regulator is
greater than 3.6 V.

Figure 5-18.  Schematics and Board Highlight of F-RAM
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5.1.10 Serial Interconnection between KitProg and Module

The KitProg is also a USB-Serial interface. It supports USB-UART and USB-I2C bridges (see
Figure 5-19). The pull-ups resistors on I2C bus are enabled when the protocol is selected from user
interface (like Bridge Control Panel). The USB-Serial pins of the KitProg are also available on the
Arduino header; therefore, it can be used to control Arduino shields with the SPI/I2C/UART interface.
Refer USB-UART Bridge on page 37 and USB-I2C Bridge on page 38 for more information on how
to use these serial interconnections. 

Figure 5-19.  Schematics and Board Highlight of Serial Interface and I2C Pull-Up via FET
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5.1.11 Module Headers

The PSoC 4 BLE and PRoC BLE Modules are connected to the BLE Pioneer Baseboard using the
two (24-pin and 20-pin) module headers, as shown in Figure 5-20. 

Figure 5-20.  Schematics and Board Highlight of Module Headers

For information on how to add these on your own board refer to Adding BLE module compatible
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Analog PinsDigital Pins

VDDA
P3_7P3_6
P3_5P3_4
P3_3P3_2
P3_1P3_0
P5_1P4_0
P5_0P4_1
P2_7P2_6
P2_5P2_4
P2_3P2_2
P2_1P2_0
GNDVDDR

GND

VDDD
P1_7
P1_5
P1_3

P0_5
P0_3
P0_1

P0_4
P0_2
P0_0

P1_6

/XRES

P1_0
P1_1 P1_2
P1_4

P0_7
P0_6

VREF

GND

J11

HEADER 10x2

1 2
3 4
5 6
7 8
9 10

11 12
13 14
15 16
17 18
19 20

J10

HEADER 12x2

1 2
3 4
5 6
7 8
9 10

11 12
13 14
15 16
17 18
19 20
21 22
23 24



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *B 103

Hardware

5.2 Module Board

5.2.1 PSoC 4 BLE or PRoC BLE Device

The PRoC BLE or PSoC 4 BLE device is the main component on the module. It provides the RF
interface and analog and digital capability. The PRoC BLE or PSoC 4 BLE pins are mapped to the
module headers (see Figure 5-21). For more information, refer to the BLE web page.

Figure 5-21.  Schematics and Board Highlight of Module Headers for BLE Pins 
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5.2.2 Module Headers (20-Pin and 24-Pin Headers)

The PSoC 4 BLE and PRoC BLE Modules connect to the BLE Pioneer Baseboard using the two (20-
pin and 24-pin) module headers (Figure 5-22). All GPIOs and power domains are brought out to
these headers. These headers are the counterparts of the connectors in Expansion Connectors on
page 92.

Figure 5-22.  Schematics and Board Highlight of Headers
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5.2.3 Wiggle Antenna

Both the modules use the wiggle antenna. Refer to the Antenna Design Guide (AN91445) for details.

Figure 5-23.  Board Highlight of Wiggle Antenna

http://www.cypress.com/go/AN91445
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5.2.4 Antenna Matching Network

An Antenna Matching Network is required between the BLE device and the antenna to achieve opti-
mum performance (Figure 5-24). The matching network has four main tasks:

■ Transform the balanced output of the radio to an unbalanced connection to the antenna (balun). 

■ Transform the output impedance of the radio to a 50-ohm antenna. 

■ Suppress harmonics to a level below the regulations level in TX mode. 

■ Suppress the local oscillator (LO) leakage in RX mode.

Figure 5-24.  Schematics and Board Highlight of Antenna Matching Network and Antenna
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5.2.5 BLE Passives

Module boards include a 24-MHz crystal and a 32-kHz crystal, the CMOD and shield (CTANK) circuit
for CapSense, a SAR bypass capacitor, and adequate decoupling capacitors for all the power
domains, as shown in Figure 5-25.

Figure 5-25.  Schematics and Board Highlight of External Crystal, CMOD, CTANK, Decaps, Jumpers 
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5.2.6 Test Points

All power domains are brought out as test points for easy probing. 

5.3 BLE Dongle Board

See PSoC 4 BLE or PRoC BLE Device on page 103 for Schematics of PRoC BLE pins. 

See Wiggle Antenna on page 105 for Schematics of Wiggle Antenna.

See Antenna Matching Network on page 106 for Schematics of Antenna Matching Network.

See BLE Pioneer Baseboard LEDs on page 97 for Schematics of Power and Status LED.

See Push Buttons on page 99 for Schematics of Push Buttons.

Figure 5-26.  Board Highlight 
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5.3.1 Power System

The BLE Dongle is powered directly using 5 V from the USB port, as shown in Figure 5-27.

Figure 5-27.  Power Supply Block Diagram With Protection Circuits

5.3.1.1 Protection Circuits

The PTC resettable fuse is connected to protect the computer's USB ports from shorts and overcur-
rent.

5.3.2 USB Type-A Plug

The KitProg on BLE Dongle connects to the USB port of a PC through a USB Type-A plug
(Figure 5-28). The BLE Dongle is powered using the same plug. A resettable polyfuse is used to pro-
tect the computer's USB ports from shorts and overcurrent. If more than 500 mA is applied to the
USB port, the fuse will automatically break the connection until the short or overload is removed. The
VBUS, D+, and D– lines from the USB connector are also protected against ESD events using TVS
diodes.

Figure 5-28.  Schematics and Board Highlight of USB Type-A Plug
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5.3.3 User LED

A user LED is provided to indicate status from the PRoC BLE device (Figure 5-29). It is also used to
show the bind status.

Figure 5-29.  Schematics and Board Highlight of User LED
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6. Advanced Topics

This chapter describes advanced features of the BLE Pioneer Kit as well as the corresponding
projects. It can be used as reference to exploit these features for other applications, according to
project requirements. 

6.1 Using FM24V10 F-RAM

The BLE Pioneer Baseboard has an onboard ferroelectric RAM chip that can hold up to 1 Mb of
data. The chip provides an I2C communication interface for data access. It is hardwired to the I2C
lines (P3_4 and P3_5). Because the F-RAM device is an I2C slave, it can be accessed or shared
among various I2C masters on the same line. For more details on the F-RAM device, refer to the
device datasheet.

6.1.1 Address Selection

The slave address of the F-RAM device consists of three parts, as shown in Figure 6-1: slave ID,
device select, and page select. Slave ID is an F-RAM family-specific ID located in the datasheet of
the particular F-RAM device. For the device used in BLE Pioneer Baseboard (FM24V10), the slave
ID is 1010b. Device select bits are set using the two physical pins A2 and A1 in the device. The set-
ting of these two pins on the BLE Pioneer Baseboard is controlled by resistors R32/R36 (A1) and
R33/R37 (A2). Because the memory location in F-RAM is divided into two pages of 64 KB each, the
page select bit is used to refer to one of the two pages in which the read or write operations will take
place.

Figure 6-1.  F-RAM I2C Address Byte Structure

6.1.2 Write/Read Operation

The device's datasheet includes details on how to perform a write/read operation with the F-RAM.
Figure 6-2 and Figure 6-3 provide a snapshot of the write/read packet structure as a quick reference.

http://www.cypress.com/?rID=73495
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Figure 6-2.  F-RAM Single-Byte and Multiple-Byte Write Packet Structure

Figure 6-3.  F-RAM Single-Byte and Multiple-Byte Read Packet Structure

As shown in the figures, all operations start with the slave address followed by the memory address.
For write operations, the bus master sends each byte of data to the memory, and the memory
generates an acknowledgement condition. For read operations, after receiving the complete slave
address and memory address, the memory begins shifting data from the current address on the next
clock. 

6.2 CySmart Mobile Application

The CySmart mobile application is a powerful tool that allows the mobile device (iOS and Android)
with BLE capability to connect to a Peripheral device and communicate with it. It supports various
standard BLE services along with two custom services for CapSense and LED control. It also
provides a common support for all profiles, standard or custom.
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This app is free. You can download and install it for Apple iOS devices from the App Store and for
Android Devices from Play Store. Make sure that the mobile device being used supports BLE.

To verify the example project using the CySmart mobile app, follow these steps.

1. Plug the BLE Pioneer Kit into the PC for power, using the J13 USB connector.

2. Program the BLE Pioneer Kit with the desired BLE example project.

3. Open the CySmart mobile application on the mobile device.

4. If Bluetooth is not enabled on the device, the app will ask to enable it, as shown in Figure 6-4.

Figure 6-4.  Turn on Bluetooth on Device

5. After Bluetooth is enabled, the app will automatically search for available Peripherals and list
them, as shown in Figure 6-5. Select the BLE Pioneer Kit in the list. The name displayed in the
list will be the same as that set in the BLE Component.

https://itunes.apple.com/WebObjects/MZStore.woa/wa/viewSoftware?id=928939093&mt=8
https://play.google.com/store/apps/details?id=com.cypress.cysmart&hl=en
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Figure 6-5.  Peripheral Connections Page

6. When connected, the CySmart mobile application will list the supported profiles by the Peripher-
als, as shown in Figure 6-6. Tap on the desired profile.

Figure 6-6.  Profiles Page

7. Depending on the type of profile chosen, the CySmart mobile application will display options for
the profile. Figure 6-7 shows an example for the CapSense slider custom profile, where swiping a
finger on the CapSense slider of the BLE Pioneer Kit is reflected in the CySmart mobile applica-
tion. See BLE Pioneer Baseboard on page 85.
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Figure 6-7.  CapSense Slider GUI

8. To go to a different service, go back to the service page in the GUI.

9. To connect to a new Peripheral, go back to home page and swipe the screen below to scan for
devices.

10.To transfer data/notifications through any other profile that is not listed on the Profiles page after
connecting to the peripheral, go to the GATT DB option on the Profiles page. The GATT DB
allows you to access the services and characteristics of a profile directly, as shown in Figure 6-8,
and to modify or receive values through BLE.

Figure 6-8.  GATT DB GUI for Characteristics
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The Data Logger option provides a textual form of all the events that has happened with a particular
Peripheral device, including scanning and connection.

Figure 6-9.  Data Logger
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A. Appendix

A.1 Schematics

A.1.1 BLE Pioneer Baseboard
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E

R17
15K

0603

C20
1.0 uF

0402

C21
0.1 uF

0603

C15
1.0 uF

0402

C8
0.1 uF

0603

C24
1.0 uF

U2

CY8C5868LTI-LP039 QFN68

P2_6
1

P2_7
2

P12_4 I2C0_SCL, SIO
3

P12_5 I2C0_SDA, SIO
4

VSSB
5

IND
6

VBOOST
7

VBAT
8

VSSD
9

XRES
10

P1_0
11

P1_1
12

P1_2
13

P1_3
14

P1_4
15

P1_5
16

VDDIO1
17

P
1_

6
18

P
1_

7
19

P
12

_6
_S

IO
20

P
12

_7
_S

IO
21

P
15

_6
 D

P
22

P
15

_7
 D

M
23

V
D

D
D

24

V
S

S
D

25

V
C

C
D

26

P
15

_0
27

P
15

_1
28

P
3_

0
29

P
3_

1
30

P
3_

2
31

P
3_

3
32

P
3_

4
33

P
3_

5
34

VDDIO3
35

V
D

D
IO

0
52

P0_3
51

P0_2
50

P0_1
49

P0_0
48

SIO_P12_3
47

SIO_P12_2
46

VSSD
45

VDDA
44

VSSA
43

VCCA
42

P15_3
41

P15_2
40

SIO, I2C1_SDA P12_1
39

SIO, I2C1_SCL P12_0
38

P3_7
37

P3_6
36

P
2_

4
66

P
2_

3
65

P
2_

2
64

P
2_

1
63

P
2_

0
62

P
15

_5
61

P
15

_4
60

V
D

D
D

59

V
S

S
D

58

V
C

C
D

57

P
0_

7
56

P
0_

6
55

P
0_

5
54

P
0_

4
53

V
D

D
IO

2
67

P
2_

5
68

E
P

A
D

69

0
6
0
3 R

16
22

E

0402

C10
0.1 uF

0603

C7
1.0 uF

0402

C18
0.1 uF

0402

C9
0.1 uF

0603

C16
1.0 uF

0402

C19
0.1 uF

0402

C14
0.1 uF

R14 ZERO

PSoC 4 / External PSoC Program/Debug HeaderPSoC 5LP Program/Debug Header

NO LOAD NO LOAD

P5LP12_2
P5LP12_3

P5LP12_4

P5LP_SWO

P5LP_XRES

P5LP_SWDCLK

P5LP_TDI

P5LP_SWDIO

VTARGP5LP_VDD

RESET

SWDCLK
SWDIO

0402

C5

0.1 uF

T
V

S
2

5V
 3

50
W

T
V

S
1

5V
 3

50
W

J7

50MIL KEYED SMD

1
3
5
7
9

2
4
6
8

10

J6

50MIL KEYED SMD

1
3
5
7
9

2
4
6
8

10

0402

C12

0.1 uF
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PSoC 5LP GPIO Expansion Header

USB-Serial Bridge Connections

P5LP12_6 ------------- UART RX
P5LP12_7 ------------- UART TX
P5LP12_0 ------------- SPI SCLK / I2C SCL
P5LP12_1 ------------- SPI MISO / I2C SDA 
P5LP12_5 ------------- SPI MOSI 
P5LP2_5  ------------- SPI SSEL

P5LP12_7P5LP12_6
P5LP3_6 P5LP3_7

P5LP0_0
P5LP1_2

P5LP3_5P5LP3_4

P5LP3_0

P5LP0_1

P5LP12_1
P5LP12_5P5LP12_0

P5LP2_5

VDD

SPI_MOSI
SPI_SSEL

UART TXUART RX

J8

8x2 RECPT

1
1

2
2

3
3

4
4

5
5

6
6

7
7

8
8

10
10

9
9

12
12

11
11

14
14

13
13

16
16

15
15

I2C Connection

Status LED

P5LP3_1

SCL

SDA

P5LP12_0

P5LP12_1

P5LP2_7

P5LP2_6

VDD

SPI_MISO / I2C_SDA

SPI_SCLK / I2C_SCL

U4
NTZD3152P

6

2 1

3
45

R23
2.2K

R27 ZERO

R11

820 ohm

R26 ZERO

0805

LED2

Status LED Green

2 1

R22
2.2K

USB MiniB 

NO LOAD

NO LOAD

CR2032 Coin Cell
Battery Holder

DP
DM

VDD

VBUS

VIN

P5LP_DM
P5LP_DP

J13

USB MINI B

VBUS
1

DM
2

DP
3

GND
5ID
4

S
1

6
S

2
7

F1

PTC Resettable Fuse

1
2

C4
100uF

0
6
0
3

D
6

SOD123

D10

0402

R6100K

0
6
0
3

D
8

04
02

C3 0.01 uF

J9

2 PIN HDR

1
1

2
2

+
-

BT1

1
3 2

TP2 RED

0
6
0
3

D
7
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NO LOAD

Protection Circuit

NO LOAD

VDDV3.3

VFRAMVDD

R9
10K

R59 ZERO

Q2

PMOS( NTR4171PT1G) 

R8
15K

D11

V
z=

2.
7V

(M
M

S
Z

46
82

T
1G

)

Q5

PMOS( PMV48XP,215)

D9

V
z=

3.
9V

(B
Z

T
52

C
3V

9-
7-

F
)

R7 ZERO

R20
10K

Q6

PMOS( NTR4171PT1G) 

R58
15K

Q4

P
M

O
S

( N
T

R
4171P

T
1G

)

Q3

PMOS(PMV48XP,215)

Q1

P
M

O
S

( D
M

P
3098L-7)

NO LOAD NO LOAD

1

2

3

4

5

6

CTL

VCC

N.C.

OUT

C

GND

Output Voltage ON / OFF control

Power supply voltage input

Unconnected terminal

Voltage output

Output voltage regulation terminal

Ground

Pin No Symbol Function.

TABLE: LDO PIN FUNCTIONS

GND Test Points

TABLE: VOLTAGE SELECTION JUMPER SETTINGS  

JUMPER SETTING O/P VOLTAGE

SHORT 2 & 3

SHORT 1 & 2

REMOVE JUMPER

3.3V

5V

1.9V

VADJ VDD

VCC

EN_CTRL

EN_CTRL

VBUS

VIN

VCC

EN_CTRL

TP5
BLACK

U1

BA00BC0WFP-E2

VCC
2

CTL
1

NC
3

OUT
4

C
5

GND
6

SOD123

D1

R1
11K
1%

R10
10K

+3216 C2
4.7uF

R4
10K 1%

SOD123

D4

R3
14.7K 1%

R5
4.3K 1%

TP6
BLACK

SOD123

D2

J16
3 PIN HDR

1 3
2

TP4
BLACK

+3216 C1
1 uFd

SOD123

D3
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NO LOAD

NO LOAD

Current Measurement Jumper

VADJ

VDD BLE_VDD

VTARG

R2

560 ohm

J15
HDR212

R44 ZERO

R45 ZERO

TP1 RED

0805

LED1

Power LED

2 1

(J1- J4) Arduino Connectors

J12 Arduino ICSP compatible header
for SPI Interface

NO LOAD

GND

/XRES

/XRES

P1_4

P1_5

P1_6

P1_7

P1_3

P1_2

P1_1

P1_0

P3_5

P3_4

P3_3

P3_2

P3_1

P3_0

P0_5

P0_4

P0_2

P0_0

P0_1

P0_3

VREF

P0_1
P0_3 P0_0

P2_0

P2_1

P2_2

P2_3

P2_4

P2_5

P3_5

P3_4

BLE_VDD

VIN

V3.3

VBUS

J2

CON6X2

A0
1

A1
3

A2
5

A3
7

A4
9

A5
11

P2.0
2

P2.1
4

P2.2
6

P2.3
8

P2.4
10

P2.5
12

J4

CON8

D0
1

D1
2

D2
3

D3
4

D4
5

D5
6

D6
7

D7
8

J3

CON10

D8
1

D9
2

D10
3

D11
4

D12
5

D13
6

GND
7

AREF
8

SDA
9

SCL
10

J12

3x2 RECPT

1 2
3 4
5 6

SOD123

D5

J1

CON8

VIN
1

GND
2

GND
3

V5.0
4

V3.3
5

Reset
6

IORef
7

NC
8

PSoC 4 BLE/PRoC BLE I/O Headers

NO LOAD

Analog PinsDigital Pins

VDDA
P3_7P3_6
P3_5P3_4
P3_3P3_2
P3_1P3_0
P5_1P4_0
P5_0P4_1
P2_7P2_6
P2_5P2_4
P2_3P2_2
P2_1P2_0
GNDVDDR

GND

VDDD
P1_7
P1_5
P1_3

P0_5
P0_3
P0_1

P0_4
P0_2
P0_0

P1_6

/XRES

P1_0
P1_1 P1_2
P1_4

P0_7
P0_6

VREF

GND

VDDR

VDDD

VDDA
BLE_VDD

L1

330 OHM @ 100MHz

J11

HEADER 10x2

1 2
3 4
5 6
7 8
9 10

11 12
13 14
15 16
17 18
19 20

TP3
RED

J10

HEADER 12x2

1 2
3 4
5 6
7 8
9 10

11 12
13 14
15 16
17 18
19 20
21 22
23 24

0402

C28
0.1 uF

0402

C26
0.1 uF

L2

330 OHM @ 100MHz

0402

C27
0.1 uF

L3

330 OHM @ 100MHz
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Shield Setting

RESET

NO LOAD

USER SWITCH

SHIELD

GND

P1_6

P3_6

P3_7

P2_6

P2_7

P2_1

P2_2

P2_3

P2_4

P2_5

/XRES

BLE_VDD

/XRES

R39 560 ohm

R42 560 ohm

CSS1

CapSense Slider 5 Seg 

5

4

3

2

1

R30 1.5K

R13 ZERO

0402

C25
0.1 uF

R12 ZERO

R43 560 ohm

R41 560 ohm

SW2

EVQ-PE105K

1 2

R40 560 ohm

R28 2.2K R29 1.5K

R G

B

LED3

RGB LED

1

2 3

4

SW1

EVQ-PE105K

1 2

F-RAM

NO LOAD NO LOAD NO LOAD

A1
A2

A1

P5_0
P5_1

WP

A2 WP

VFRAM

VFRAM

VFRAM VFRAM

VFRAM

VFRAM

R32
ZERO

R37
ZERO

U3

FM24V10

A1
2

VSS
4 SCL

6

VDD
8

NC
1

A2
3

SDA
5

WP
7C29

33uF

R36
ZERO

R35
2.2K

0402

C23

0.1 uF

R33
ZERO

R34
ZERO

R38
ZERO

R31
2.2K

Proximity Header

PMOD Connector
NO LOAD

P0_2

P0_0

P0_1

P0_3
P2_0

V
D

D

J14

1x1 RECP

J5

CON6

SS
1

MOSI
2

MISO
3

SCK
4

GND
5

VCC
6

R19 ZERO

NO LOAD

USB-I2C

USB-SPI

USB-UART

USB-SWD

PSoC 5LP and PSoC 4 BLE/PRoC BLE Connections

NO LOAD

NO LOAD

NO LOAD
P0_3

P0_1

P0_2

P0_0

P3_5

P3_4

/XRES

P0_7

P0_6

P1_5

P1_4

SPI_MOSI

SPI_SSEL

SPI_MISO / I2C_SDA

SPI_SCLK / I2C_SCL

RESET

SWDIO

SWDCLK

UART TX

UART RX R52 ZERO

R53 ZERO

R54 ZERO
R49 ZERO

R50 ZERO

R56 ZERO

R46 ZERO

R55 ZERO

R48 ZERO

R51 ZERO

R47 ZERO
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A.1.2 Module

SAR bypass

CMODShunt 
Resistor C_Tank

KHz Crystal

MHz Crystal

TX
RX

Analog Pins

Serial Interface

No Load

No Load

No Load

No Load

No Load

Digital Pins

No Load

PCA: 121-60159-01
PCB: 600-60195-01
FAB DRW: 610-60187-01
ASSY DRW: 620-60195-01

No Load

No Load

No Load
No Load

No Load P4.0 P4.1

P6.0

P6.1

XTAL24O

XTAL24I

P6.0
P6.1
/XRES
P4.0
P4.1
P5.0
P5.1

X
TA

L2
4I

X
TA

L2
4O

P
2.

6
P

2.
7

P
3.

0
P

3.
1

P
3.

2
P

3.
3

P
3.

4
P

3.
5

P
3.

6
P

3.
7

P1.5
P1.4

/XRES

P1.6
P1.5
P1.4
P1.3
P1.2
P1.1

P2.4
P2.3
P2.2
P2.1
P2.0

P1.7

P2.5

P3.7P3.6
P3.5P3.4
P3.3P3.2
P3.1P3.0
P5.1P4.0
P5.0P4.1
P2.7P2.6
P2.5P2.4
P2.3P2.2
P2.1P2.0

P1.7
P1.5
P1.3

P0.5
P0.3
P0.1

P0.4
P0.2
P0.0

P1.6

/XRES

P1.0
P1.1 P1.2
P1.4

P0.7
P0.6

P
0.

0
P

0.
1

P
0.

2
P

0.
3

P
0.

4
P

0.
5

P
0.

6
P

0.
7

P
1.

0

VDDD

VDDA

VDDR

VCCD

VDDD

VREF

VDDR

VDDA VREF

VDDR VDDDVDDA

VDDD

VCCD VDDD

VDDA

VDDA

VDDR

VDDD

VREF

VDDD

Title

Size Document Number Rev

CYPRESS SEMICONDUCTOR  © 2014

CY8CKIT-142 PSoC 4 BLE Module
Title

Size Document Number Rev

CYPRESS SEMICONDUCTOR  © 2014

CY8CKIT-142 PSoC 4 BLE Module
Title

Size Document Number Rev

CYPRESS SEMICONDUCTOR  © 2014

CY8CKIT-142 PSoC 4 BLE Module

0603

C10

1.0 uF0402

C9

0.1 uF

C13

1.2 pF

0603

C20
1.0 uF

J2

HEADER 10x2

1 2
3 4
5 6
7 8
9 10

11 12
13 14
15 16
17 18
19 20

0603

C2

1.0 uF

L4

33
0 

O
H

M
 @

 1
00

M
H

z

0402

C1

0.1 uF

TP2
RED

C23
36 pF

C22
10000 pF

0603

C4

1.0 uF

0603

C25

100 pF

0603

C17

1.0 uF

0603

C6

1.0 uF0402

C3

0.1 uF

0402

C16

0.1 uF

0402

C5

0.1 uF

C21
2200 pF

L3

33
0 

O
H

M
 @

 1
00

M
H

z

TP1
RED

0603

C8

1.0 uF

0603

C19

1.0 uF

R1

Zero Ohm
0402

C18

0.1 uF

0603

C15

1.0 uFJ3

4 HEADER

1
2
3
4

R2
Zero Ohm

L1
6.8nH

0603

C12

1.0 uF

C24
18 pF

TP3
RED

0402

C11

0.1 uF

Y1
32.768KHz

1
2

TP5
BLACK

CY8C4247LQI-BL483

U1

VDDD
1

XTAL32O/P6.0
2

XTAL32I/P6.1
3

XRES
4

P4.0
5

P4.1
6

P5.0
7

P5.1
8

VSSD
9

VDDR
10

GANT1
11

ANT
12

GANT2
13

VDDR
14

P2.5
42

P2.4
41

P2.3
40

P2.2
39

P2.1
38

P2.0
37

VDDA
36

P1.7
35
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P1.3
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E
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S

S
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P
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D
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X
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A.1.3 BLE Dongle

NO LOAD

NO LOAD

I2C Connection

Power and Status LED

USB A PLUG

NO LOAD

USB Connection

PSoC 5LP Programmer / Debugger

NO LOAD NO LOADNO LOAD

PCA: 121-60161-01
PCB: 600-60197-01
FAB DRW: 610-60189-01
ASSY DRW: 620-60197-01

SAR Bypass
Capacitor

P5LP0_4 to P5LP0_7,
P5LP3_2, P5LP3_3 are 
reserved for HW REV ID

NO LOAD

SAR Bypass
Capacitor

Del Sig Bypass
Capacitor

PRoC Program/Debug Header

NO LOAD NO LOAD NO LOAD

PSoC 5LP and PRoC BLE Connections

P5LP12_0

P5LP12_1

P5LP_XRES

P5LP2_7

P5LP2_6

SCL

SDA

DM
DP

P
5L

P
_S

W
D

IO

P
5L

P
_S

W
D

C
LK

P5LP3_1

P5LP_POWER

P
5L

P
_X

R
E

S

P
5L

P
0_

4

V
S

S
D

P5LP_SWDCLK
P5LP_SWDIO

P5LP_SWO

P5LP12_5

P5LP_XRES

P
5L

P
_D

P
P

5L
P

_D
M

D
M

_P

P5LP0_3

D
P

_P

P5LP0_0
P5LP0_1

P5LP12_0

P
5L

P
12

_6
P5LP12_1

VSSD

VSSD

P
5L

P
12

_7

P5LP2_6
P5LP2_7

P5LP12_4

P5LP3_7
P5LP3_6

P5LP0_2

V
S

S
D

P
5L

P
3_

0

P5LP12_3

P
5L

P
3_

4
P

5L
P

3_
5

P
5L

P
1_

7

P5LP1_6

P
5L

P
3_

1

P
5L

P
_V

C
C

D

P5LP_POWER

P
5L

P
_V

C
C

D

P
5L

P
2_

5

P
5L

P
0_

5

P
5L

P
15

_4

P5LP1_2

P5LP12_2

P5LP12_2
P5LP12_3

P5LP12_4

SWDIO

SWDCLK

/XRES

P5LP12_5
P5LP12_1
P5LP2_5
P5LP12_0

P5LP12_7
P5LP12_6

V
B

U
S

P
5L

P
15

_4

P5LP_VDD

P5LP_VDD VBUS

VTARG

VBUS

VTARG VBUS

P5LP_VDD
P5LP_VDD

P5LP_VDD
P5LP_VDD

P5LP_VDD

P5LP_VDD

P5LP_VDD

VTARGVBUS

VTARG

SDA

SCL

P5LP_DM
P5LP_DP

P
5L

P
_D

P
P

5L
P

_D
M

E
X

TR
A

/XRES

SWDCLK

SWDIO

P5LP12_5
P5LP12_1
P5LP2_5
P5LP12_0

P5LP12_6
P5LP12_7

Title

Size Document Number Rev
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A.2 Board Layout

A.2.1 BLE Pioneer Baseboard

Figure A-1.  Primary Side of BLE Pioneer Baseboard 

Figure A-2.  Ground Layer of BLE Pioneer Baseboard

Figure A-3.  Power Layer of BLE Pioneer Baseboard
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Figure A-4.  Secondary Side of BLE Pioneer Baseboard

Figure A-5.  Primary Silkscreen of BLE Pioneer Baseboard 

Figure A-6.  Secondary Silkscreen of BLE Pioneer Baseboard 
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A.2.2 PRoC BLE Module

Figure A-7.  Primary Side of PRoC BLE Module

Figure A-8.  Ground Layer of PRoC BLE Module

Figure A-9.  VCC Layer of PRoC BLE Module
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Figure A-10.  Secondary Side of PRoC BLE Module

Figure A-11.  Primary Silkscreen of PRoC BLE Module

Figure A-12.  Secondary Silkscreen of PRoC BLE Module
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A.2.3 PSoC 4 BLE Module

Figure A-13.  Primary Side of PSoC 4 BLE Module

Figure A-14.  Ground Layer of PSoC 4 BLE Module

Figure A-15.  VCC Layer of PSoC 4 BLE Module
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Figure A-16.  Secondary Side of PSoC 4 BLE Module

Figure A-17.  Primary Silkscreen of PSoC 4 BLE Module

Figure A-18.  Secondary Silkscreen of PSoC 4 BLE Module
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A.2.4 BLE Dongle

Figure A-19.  Primary Side of BLE Dongle

Figure A-20.  Ground Layer of BLE Dongle

Figure A-21.  Power Layer of BLE Dongle
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Figure A-22.  Secondary Side of BLE Dongle

Figure A-23.  Primary Silkscreen of BLE Dongle

Figure A-24.  Secondary Silkscreen of BLE Dongle
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A.3 Bill of Materials (BOM)

A.3.1 BLE Pioneer Baseboard

Item Qty Reference Value Description Manufacturer Mfr Part Number

1 -

PCB, 106.22 mm x 53.34 
mm, High Tg, ENIG finish, 
4 layer, Color = RED, Silk = 
WHITE.

Cypress

2 1 BT1
CR2032 Bat-
tery Holder

HOLDER COIN CELL 
CR2032 EJECT

MPD BA2032

3 1 C1 1.0 uF
CAP TANT 1UF 35V 10% 
1210

AVX Corporation TAJB105K035RNJ

4 1 C2 4.7 uF
CAP TANT 4.7UF 20V 
10% 1210

AVX Corporation TAJB475K020RNJ

5 1 C3 0.01 uFd
CAP 10000PF 16V 
CERAMIC 0402 SMD

TDK Corporation C1005X7R1C103K050BA

6 1 C4 100 uFd
CAP CER 100UF 6.3V 
20% X5R 1210

TDK Corporation C3225X5R0J107M250AC

7 15

C5,C8,C9,C10,C1
2,C14,C17,C18,C
19,C21,C23,C25,
C26,C27,C28

0.1 uFd
CAP .1UF 16V CERAMIC 
X5R 0402

TDK Corporation C1005X5R1A104K050BA

8 7
C6,C7,C11,C13,C
15,C16,C20

1.0 uFd
CAP CERAMIC 1.0UF 25V 
X5R 0603 10%

Taiyo Yuden TMK107BJ105KA-T

9 1 C29 33 uF
CAP CER 33UF 6.3V 20% 
X5R 0805

TDK Corporation C2012X5R0J336M125AC

10 6
D1,D2,D3,D4,D5,
D10

MBR0520L
DIODE SCHOTTKY 0.5A 
20V SOD-123

Fairchild Semicon-
ductor

MBR0520L

11 3 D6,D7,D8 ESD diode
SUPPRESSOR ESD 
5VDC 0603 SMD

Bourns Inc. CG0603MLC-05LE

12 1 D9 3.9V Zener
DIODE ZENER 3.9V 
500MW SOD12

Diodes Inc BZT52C3V9-7-F

13 1 D11 2.7V Zener
DIODE ZENER 2.7V 
500MW SOD123

ON Semiconductor MMSZ4682T1G

14 1 F1 FUSE
PTC RESETTABLE .50A 
15V 1812

Bourns MF-MSMF050-2

15 2 J1, J4 8x1 RECP 
CONN HEADER FEMALE 
8POS .1" GOLD

Protectron Electro-
mech

P9401-08-21

16 1 J2 6x2 RECP
CONN HEADER FMAL 
12PS.1" DL GOLD

Protectron Electro-
mech

P9403-12-21

17 1 J3 10x1 RECP
CONN HEADER FMALE 
10POS .1" GOLD

Protectron Electro-
mech

P9401-10-21

18 1 J8 8X2 RECP
CONN HEADER FMAL 
16PS.1" DL GOLD

Protectron Electro-
mech

P9403-16-21

19 1 J10 12X2 RECP
CONN HEADER 2.54MM 
24POS GOLD

Sullins Connector 
Solutions

SBH11-PBPC-D12-ST-BK

20 1 J11 10X2 RECP
CONN HEADER 2.54MM 
20POS GOLD

Sullins Connector 
Solutions

SBH11-PBPC-D10-ST-BK

21 1 J13 USB MINI B MINI USB RCPT R/A DIP TE Connectivity 1734510-1
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22 1 J14 1X1 RECP
CONN RCPT 1POS .100" 
SNGL HORZ

Samtec Inc BCS-101-L-S-HE

23 1 J15 2p_jumper
CONN HEADR BRKWAY 
.100 2POS STR

Protectron Electro-
mech

P9101-02-12-1

24 1 J16 3p_jumper
CONN HEADR BRKWAY 
.100 3POS STR

Protectron Electro-
mech

P9101-03-12-1

25 1 LED1
Power LED 
Amber

LED 595NM AMB DIFF 
0805 SMD

Avago Technolo-
gies 

HSMA-C170

26 1 LED2
Status LED 
Green

LED GREEN CLEAR 0805 
SMD

Chicago Miniature CMD17-21VGC/TR8

27 1 LED3 RGB LED
LED RED/GREEN/BLUE 
PLCC4 SMD

Cree, Inc.
CLV1A-FKB-
CJ1M1F1BB7R4S3

28 3 L1,L2,L3
330 OHM @ 
100MHz

FERRITE CHIP 330 OHM 
0805

Murata BLM21PG331SN1D

29 3 Q2,Q4,Q6 PMOS
MOSFET P-CH 30V 2.2A 
SOT23

ON Semiconductor NTR4171PT1G

30 1 Q1, PMOS
MOSFET P-CH 30V 3.8A 
SOT23-3

Diodes Inc DMP3098L-7

31 2 Q3,Q5 PMOS
MOSFET P-CH 20V 3.5A 
SOT23

NXP Semiconduc-
tors

PMV48XP,215

32 1 R1 11K 1%
RES 11K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF1102V

33 1 R2 560 ohm
RES 560 OHM 1/8W 5% 
0805 SMD

Panasonic - ECG ERJ-6GEYJ561V

34 1 R3 14.7K 1%
RES 14.7K OHM 1/10W 
1% 0603 SMD

Panasonic - ECG ERJ-3EKF1472V

35 1 R4 10K 1%
RES 10K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF1002V

36 1 R5 4.3K 1%
RES 4.3K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF4301V

37 1 R6 100K
RES 100K OHM 1/10W 5% 
0402 SMD

Panasonic - ECG ERJ-2GEJ104X

38 14

R19,R26,R27,R3
6,R37,R38,R45,R
46,R47,R52,R53,
R54,R55,R56

ZERO
RES 0.0 OHM 1/10W 0603 
SMD

Panasonic - ECG ERJ-3GEY0R00V

39 2 R8,R58 15K
RES 15K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF1502V

40 2 R9,R20 10K 1%
RES 10K OHM 1/8W 1% 
0805 SMD

Stackpole Electron-
ics Inc

RMCF0805FT10K0 

41 1 R10 10K
RES 10K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ103V

42 1 R11 820 ohm
RES 820 OHM 1/8W 5% 
0805 SMD

Panasonic - ECG ERJ-6GEYJ821V

43 2 R13,R14 ZERO
RES 0.0 OHM 1/8W 0805 
SMD

Panasonic-ECG ERJ-6GEY0R00V

44 2 R15,R16 22E
RES 22 OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF22R0V

45 2 R17,R18 15K
RES 15K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ153V

Item Qty Reference Value Description Manufacturer Mfr Part Number
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46 5
R22,R23,R28,R3
1,R35 

2.2K
RES 2.2K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ222V

47 2 R24,R25 30K
RES 30K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ303V

48 2 R29,R30 1.5K
RES 1.5K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ152V

49 5
R39,R40,R41,R4
2,R43

560 ohm
RES 560 OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ561V

50 2 SW1,SW2
SW PUSH-
BUTTON

SWITCH TACTILE SPST-
NO 0.05A 12V

Panasonic - ECG EVQ-PE105K

51 1 TP5 BLACK
TEST POINT PC MINI 
.040"D Black

Keystone Electron-
ics

5001

52 2 TVS1,TVS2 5V 350W
TVS UNIDIR 350W 5V 
SOD-323

Dioded Inc. SD05-7

53 1 U1 LDO
IC REG LDO ADJ 1A 
TO252-5

Rohm Semiconduc-
tor

BA00BC0WFP-E2

54 1 U2 PSoC 5LP 
68QFN PSoC 5LP chip for 
USB debug channel and 
USB-Serial interface

Cypress Semicon-
ductor

CY8C5868LTI-LP039

55 1 U3 F-RAM
F-RAM 1-Mbit (128K X 8) 
I2C interface

Cypress Semicon-
ductor

FM24V10-G

56 1 U4 DUAL PMOS
MOSFET 2P-CH 20V 
430MA SOT-563

ON Semiconductor NTZD3152PT1G

Install on Bottom of PCB As per the Silk Screen in the Corners

57 4 N/A N/A
BUMPER CYLIN 0.375" 
DIA BLK

3M SJ61A4

Special Jumper Installation Instructions

58 2 J15,J16
Install jumper 
across pins 1 
and 2 

Rectangular Connectors 
MINI JUMPER GF  6.0MM 
CLOSE TYPE BLACK

Kobiconn 151-8010-E

Label

59 1 N/A N/A

LBL, PCA Label, Vendor 
Code, Datecode, Serial 
Number 121-60158-01 Rev 
04 (YYWWVVXXXXX)

Cypress Semicon-
ductor

60 1 N/A N/A
LBL, QR code, 12mm X 
12mm

Cypress Semicon-
ductor

No load components

61 1 C22 0.1 uFd
CAP .1UF 16V CERAMIC 
Y5V 0402

TDK Corporation C1005X5R1A104K050BA

62 1 C24 1.0 uFd
CAP CERAMIC 1.0UF 25V 
X5R 0603 10%

Taiyo Yuden TMK107BJ105KA-T

63 9
R7,R59,R32,R33,
R34,R48,R49,R5
0,R51

Zero Ohm
RES 0.0 OHM 1/10W 
JUMP 0603

TE Connectivity 1623094-1

64 1 R21 4.7K
RES 4.7K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ472V

65 2 J7,J6
50MIL KEYED 
SMD

CONN HEADER 10 PIN 
50MIL KEYED SMD

Samtec FTSH-105-01-L-DV-K

Item Qty Reference Value Description Manufacturer Mfr Part Number
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66 1 J9 2 PIN HDR
CONN HEADER FEMALE 
2POS .1" GOLD

Sullins Connector 
Solutions

PPPC021LFBN-RC

67 2 TP4,TP5 BLACK
TEST POINT 43 HOLE 65 
PLATED BLACK

Keystone Electron-
ics

5001

68 3 TP1,TP2,TP3 RED
TEST POINT 43 HOLE 65 
PLATED RED

Keystone Electron-
ics

5000

69 2 R44,R12 ZERO
RES 0.0 OHM 1/8W 0805 
SMD

Panasonic-ECG ERJ-6GEY0R00V

70 1 J12 3x2 RECPT
CONN HEADER FMAL 
6PS .1" DL GOLD

Sullins Connector 
Solutions

PPPC032LFBN-RC

71 1 J5 6X1 RECP RA
CONN FEMALE 6POS 
.100" R/A GOLD

Sullins Connector 
Solutions

PPPC061LGBN-RC

Item Qty Reference Value Description Manufacturer Mfr Part Number
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A.3.2 Module

A.3.2.1 CY5671 PRoC BLE Module

Item Qty Reference Value Description Manufacturer Mfr Part Number

1 1 600-60196-01 -
PRoC BLE Module printed 
circuit board 

Cypress qualified ven-
dor 

600-60196-01 Rev03

2 8
C1,C3,C5,C7,C9,C
11,C16,C18

0.1 uF
CAP .1UF 16V CERAMIC 
Y5V 0402

Samsung Electro-
Mechanics America, 
Inc

CL05F104ZO5NNNC

3 10
C2,C4,C6,C8,C10,
C12,C15,C17,C19,
C20

1.0 uF
CAP CERAMIC 1.0UF 
25V X5R 0603 10%

TDK Corporation C1608X5R1E105K080AC

4 1 C21 2200 pF
CAP CER 2200PF 50V 
5% NP0 0805

Murata Electronics GRM2165C1H222JA01D

5 1 C22
10000 
pF

CAP CER 10000PF 50V 
5% NP0 0805

Murata Electronics GRM2195C1H103JA01D

6 1 C23 36 pF
CAP CER 36PF 50V 5% 
NP0 0402

Murata Electronics GRM1555C1H360JA01D

7 1 C24 18 pF
CAP CER 18PF 50V 1% 
NP0 0402

Murata Electronics GRM1555C1H180FA01D

8 1 C14 1.5 pF
CAP CER 1.5PF 50V NP0 
0402

Johanson Technology 
Inc

500R07S1R5BV4T

9 1 J1
HEADE
R 24

CONN HEADR FMALE 
24POS .1" DL AU

Sullins Connector SFH11-PBPC-D12-ST-BK

10 1 J2
HEADE
R 20

CONN HEADR FMALE 
20POS .1" DL AU

Sullins Connector SFH11-PBPC-D10-ST-BK

11 1 L1 6.8nH
CER INDUCTOR 6.8NH 
0402

Johanson Technology 
Inc

L-07C6N8JV6T

12 3 L2,L3,L4
330 Ohm 
@100 
MHz

FERRITE CHIP 330 OHM 
0805

Murata Electronics BLM21PG331SN1D

13 1 U1
PRoC 
BLE

56 QFN PRoC BLE 
Cypress Semiconduc-
tor

CYBL10563-56LQXI

14 1 Y1
32.768K
Hz

CRYSTAL 32.768KHZ 
12.5PF SMD

ECS Inc ECS-.327-12.5-34B

15 1 Y2 24MHz
CRYSTAL 24.000 MHZ 
8PF SMD

ECS Inc ECS-240-8-36CKM

16 1 LBL -

LBL, PCA Label, Vendor 
Code, Datecode, Serial 
Number 121-60160-01 
Rev 04 (YYWWV-
VXXXXX)

Cypress qualified ven-
dor 

-

No Load components

17 1 C13 1.2 pF
CAP CER 1.2PF 50V NP0 
0402

Johanson Technology 
Inc

500R07S1R2BV4T

18 1 C25 100pF
CAP CER 100PF 50V 
10% X7R 0603

Kemet C0603C101K5RACTU



138 CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *B

19 1 R1
Zero 
Ohm

RES 0.0 OHM 1/8W 0605 
SMD

TE Connectivity 1623094-1

20 1 R2 Rbleed No Load - -

21 1 R3 4.7K
RES 4.7K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ472V

22 1 J3
4 
HEADE
R

CONN HEADER 4POS 
.100 R/A 15AU

FCI 68016-204HLF

23 4 TP1,TP2,TP3,TP4 RED
TEST POINT 43 HOLE 65 
PLATED RED

Keystone Electronics 5000

24 1 TP5 BLACK
TEST POINT 43 HOLE 65 
PLATED BLACK

Keystone Electronics 5001

Item Qty Reference Value Description Manufacturer Mfr Part Number
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A.3.2.2 CY8CKIT-142 PSoC 4 BLE Module

Item Qty Reference Value Description Manufacturer Mfr Part Number

1 1 600-60195-01 -
PSoC 4 BLE Module 
printed circuit board 

Cypress qualified 
vendor 

600-60195-01 Rev03

2 8
C1,C3,C5,C7,C9,
C11,C16,C18

0.1 uF
CAP .1UF 16V CERAMIC 
Y5V 0402

Samsung Electro-
Mechanics Amer-
ica, Inc

CL05F104ZO5NNNC

3 10
C2,C4,C6,C8,C10
,C12,C15,C17,C1
9,C20

1.0 uF
CAP CERAMIC 1.0UF 25V 
X5R 0603 10%

TDK Corporation C1608X5R1E105K080AC

4 1 C21 2200 pF
CAP CER 2200PF 50V 5% 
NP0 0805

Murata Electronics GRM2165C1H222JA01D

5 1 C22 10000 pF
CAP CER 10000PF 50V 
5% NP0 0805

Murata Electronics GRM2195C1H103JA01D

6 1 C23 36 pF
CAP CER 36PF 50V 5% 
NP0 0402

Murata Electronics GRM1555C1H360JA01D

7 1 C24 18 pF
CAP CER 18PF 50V 1% 
NP0 0402

Murata Electronics GRM1555C1H180FA01D

8 1 C14 1.5 pF
CAP CER 1.5PF 50V NP0 
0402

Johanson Technol-
ogy Inc

500R07S1R5BV4T

9 1 J1
HEADER 
24

CONN HEADR FMALE 
24POS .1" DL AU

Sullins Connector SFH11-PBPC-D12-ST-BK

10 1 J2
HEADER 
20

CONN HEADR FMALE 
20POS .1" DL AU

Sullins Connector SFH11-PBPC-D10-ST-BK

11 1 L1 6.8nH
CER INDUCTOR 6.8NH 
0402

Johanson Technol-
ogy Inc

L-07C6N8JV6T

12 3 L2,L3,L4
330 Ohm 
@100 
MHz

FERRITE CHIP 330 OHM 
0805

Murata Electronics BLM21PG331SN1D

13 1 U1
PSoC 
4BLE

56 QFN PSoC 4 BLE 
Cypress Semicon-
ductor

CY8C4247LQI-BL483

14 1 Y1
32.768K
Hz

CRYSTAL 32.768KHZ 
12.5PF SMD

ECS Inc ECS-.327-12.5-34B

15 1 Y2 24MHz
CRYSTAL 24.000 MHZ 
8PF SMD

ECS Inc ECS-240-8-36CKM

16 1 LBL -

LBL, PCA Label, Vendor 
Code, Datecode, Serial 
Number 121-60159-01 Rev 
04 (YYWWVVXXXXX)

Cypress qualified 
vendor 

-

No Load components

17 1 C13 1.2 pF
CAP CER 1.2PF 50V NP0 
0402

Johanson Technol-
ogy Inc

500R07S1R2BV4T

18 1 C25 100pF
CAP CER 100PF 50V 10% 
X7R 0603

Kemet C0603C101K5RACTU

19 1 R1
Zero 
Ohm

RES 0.0 OHM 1/10W 
JUMP 0603

TE Connectivity 1623094-1

20 1 R2 Rbleed No Load - -
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21 1 R3 4.7K
RES 4.7K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ472V

22 1 J3
4 
HEADER

CONN HEADER 4POS 
.100 R/A 15AU

FCI 68016-204HLF

23 4 TP1,TP2,TP3,TP4 RED
TEST POINT 43 HOLE 65 
PLATED RED

Keystone Electron-
ics

5000

24 1 TP5 BLACK
TEST POINT 43 HOLE 65 
PLATED BLACK

Keystone Electron-
ics

5001

Item Qty Reference Value Description Manufacturer Mfr Part Number
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A.3.3 BLE Dongle

Item Qty Reference Value Description Manufacturer Mfr Part Number

1 1 600-60197-01 -

PCB, 60 mm x 30 mm, 
High Tg, ENIG finish, 2 
layer, Color = BLACK, 
Silk = WHITE.

Cypress qualified 
vendor 

600-60197-01 Rev02

2 17

C1,C4,C6,C7,C9,C11
,C14,C16,C25,C28,C
29,C32,C35,C36,C38
,C41,C42

0.1 uFd
CAP .1UF 16V 
CERAMIC Y5V 0402

TDK Corporation C1005X5R1A104K050BA

3 17

C2,C3,C5,C8,C10,C
12,C13,C15,C17,C18
,C24,C26,C30,C31,C
33,C34,C40

1.0 uFd
CAP CERAMIC 1.0UF 
25V X5R 0603 10%

Taiyo Yuden TMK107BJ105KA-T

4 1 C19 1.2 pFd
CAP CER 1.2PF 50V 
NP0 0402

Johanson Technol-
ogy Inc

500R07S1R2BV4T

5 1 C22 36 pF
CAP CER 36PF 50V 5% 
NP0 0402

Murata Electronics GRM1555C1H360JA01D

6 1 C23 18 pF
CAP CER 18PF 50V 1% 
NP0 0402

Murata Electronics GRM1555C1H180FA01D

7 1 C39 0.01 uFd
CAP 10000PF 16V 
CERAMIC 0402 SMD

TDK Corporation C1005X7R1C103K050BA

8 3 D1,D2,D3
ESD 
diode

SUPPRESSOR ESD 
5VDC 0603 SMD

Bourns Inc. CG0603MLC-05LE

9 1 F1 FUSE
PTC RESETTABLE 
.50A 15V 1812

Bourns MF-MSMF050-2

10 1 J1
USB 
Type-A 
PLUG

CONN PLUG USB 
4POS RT ANG PCB

Molex Inc 480370001

11 1 J2
50MIL 
KEYED 
SMD

CONN HEADER 10POS 
DUAL SHRD SMD

FCI 20021521-00010T1LF

12 1 LED1
Status 
LED Blue

LED BLUE CLEAR 
THIN 0805 SMD

LiteOn Inc LTST-C171TBKT

13 1 LED2
Status 
LED 
Green

LED GREEN CLEAR 
0805 SMD

Chicago Miniature CMD17-21VGC/TR8

14 1 LED3
Power 
LED Red

LED SUPER RED 
CLEAR 0805 SMD

LiteOn Inc LTST-C170KRKT

15 1 L1 5.1 nH
CER INDUCTOR 5.1NH 
0402

Johanson Technol-
ogy Inc

L-07C5N1SV6T

16 2 R8,R11
Zero 
Ohm

RES 0.0 OHM 1/8W 
0805 SMD

Panasonic-ECG ERJ-6GEY0R00V

17 1 R7 820 ohm
RES 820 OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ821V

18 2 R22,R25 820 ohm
RES 820 OHM 1/8W 5% 
0805 SMD

Panasonic - ECG ERJ-6GEYJ821V

19 2 R9,R10 2.2K
RES 2.2K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ222V
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20 9
R1,R2,R3,R4,R12,R
13,R14,R15,R26

ZERO
RES 0.0 OHM 1/10W 
0603 SMD

Panasonic - ECG ERJ-3GEY0R00V

21 2 R17,R18 22E
RES 22 OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF22R0V

22 1 R21 100K
RES 100K OHM 1/10W 
5% 0402 SMD

Panasonic - ECG ERJ-2GEJ104X

23 2 R19,R20 15K
RES 15K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ153V

24 2 R23,R24 30K
RES 30K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ303V

25 2 SW1,SW2
SW RA 
PUSH

SWITCH TACTILE 
SPST-NO 0.05A 12V

Panasonic - ECG EVQ-P3401P

26 1 TVS1 5V 350W
TVS UNIDIR 350W 5V 
SOD-323

Diodes Inc. SD05-7

27 1 U1
PRoC 
BLE

PRoC BLE, Programma-
ble Radio on Chip, 
56QFN

Cypress Semiconduc-
tor

CYBL10162-56LQXI

28 1 U2
DUAL 
PMOS

MOSFET 2P-CH 20V 
430MA SOT-563

ON Semiconductor NTZD3152PT1G

29 1 U3
PSoC 
5LP 

PSoC 5LP Programma-
ble System on Chip, 
68QFN

Cypress Semiconduc-
tor

CY8C5868LTI-LP039

30 1 Y1
32.768K
Hz

CRYSTAL 32.768KHZ 
12.5PF SMD

ECS Inc ECS-.327-12.5-34B

31 1 Y2 24MHz
CRYSTAL 24.000 MHZ 
8PF SMD

ECS Inc ECS-240-8-36CKM

32 1 N/A N/A

LBL, PCA Label, Ven-
dor Code, Datecode, 
Serial Number 121-
60161-01 Rev 03 (YYW-
WVVXXXXX); Only bar-
code

Cypress qualified 
vendor 

-

No load components

33 1 C20 1.2 pF
CAP CER 1.2PF 50V 
NP0 0402

Johanson Technol-
ogy Inc

500R07S1R2BV4T

34 1 C21 100pF
CAP CER 100PF 50V 
10% X7R 0603

Kemet C0603C101K5RACTU

35 1 C37 0.1 uFd
CAP .1UF 16V 
CERAMIC Y5V 0402

TDK Corporation C1005X5R1A104K050BA

36 1 C27 1.0 uFd
CAP CERAMIC 1.0UF 
25V X5R 0603 10%

Taiyo Yuden TMK107BJ105KA-T

37 1 R5
Zero 
Ohm

RES 0.0 OHM 1/10W 
JUMP 0603

TE Connectivity 1623094-1

38 2 R6,R16 4.7K
RES 4.7K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ472V

39 15

TP1,TP2,TP3,TP4,T
P5,TP6,TP7,TP8,TP
9,TP10,TP11,TP12,T
P13,TP14,TP15

No load No load - -

Item Qty Reference Value Description Manufacturer Mfr Part Number
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A.4 KitProg Status LED States

User Indication Scenario Action Required by user

1
LED blinks fast:

Frequency = 4.00 Hz
LED starts blinking at power up, 
if bootloadable file is corrupt.

Bootload the KitProg.cyacd file: in PSoC Programmer, con-
nect to the kit, open the Utilities tab and press Upgrade 
Firmware button.

2
LED blinks slow:

Frequency = 0.67 Hz

Entered Bootloader mode by 
holding the BLE Pioneer Kit/BLE 
Dongle Reset button during kit 
power-up.

Release the Reset button and re-plug power if you entered 
this mode by mistake. If the mode entry was intentional, 
bootload the new.cyacd file using the Bootloader Host tool 
shipped with PSoC Creator.

3
LED blinks very fast:

Frequency = 15.0 Hz

SWD operation is in progress.

Any I2C traffic.

Kit's COM port connect/discon-
nect event (one blink).

In PSoC Programmer, watch the log window for status mes-
sages for SWD operations. In the Bridge Control Panel, the 
LED blinks on I2C command requests. In BCP or any other 
serial port terminal program, distinguish the kit's COM port 
number by the blinking LED when the port is connected or 
disconnected.

4 LED is ON.
USB enumeration successful. 

Kit is in the idle state waiting for 
commands.

The kit functions can be used by PSoC Creator, PSoC Pro-
grammer, Bridge Control Panel, and any serial port terminal 
program.

5 LED is OFF. Power LED is ON.

This means that the USB enumeration was unsuccessful. 
This can happen if the kit is not powered from the USB host 
or the kit is not connected to the USB host through the USB 
cable. Verify the USB cable and check if PSoC Programmer 
is installed on the PC.
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A.5 Adding BLE module compatible headers on your own baseboard

The baseboard should have two headers, one 20-pin and another 24-pin. Dimension of these
connects are detailed below. 

You can get these at Digikey. 

# Description Manufacturer Mfr Part Number Digikey part #

1 CONN HEADER 2.54MM 

24POS GOLD

Sullins Connector 

Solutions

SBH11‐PBPC‐D12‐ST‐BK SBH11‐PBPC‐D12‐ST‐BK‐ND

2 CONN HEADER 2.54MM 

20POS GOLD

Sullins Connector 

Solutions

SBH11‐PBPC‐D10‐ST‐BK S9172‐ND

940 mils

740 mils

Pin 1

Pin 1

20 pin header 

24 pin header 

http://www.digikey.com/product-search/en?x=12&y=21&lang=en&site=us&keywords=SBH11-PBPC-D12-ST-BK
http://www.digikey.com/product-search/en?KeyWords=SBH11-PBPC-D10-ST-BK&WT.z_header=search_go
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